
 

 

    



 

P a g e  |  2 W W W . L O G O S . C O M   

COPYRIGHT NOTICE ........................................................................................................................................................................... 6 
FREE RESOURCES ............................................................................................................................................................................... 6 

Get LOGOS for FREE! $1,500 Value ................................................................................................................................................... 6 
Get FREE Books & Resources ............................................................................................................................................................. 6 
iDENTITY iNTELLIGENCE Logos Group ............................................................................................................................................... 6 

HOW TO USE THIS MANUAL .............................................................................................................................................................. 6 

UPDATES AND VERSION HISTORY ................................................................................................................................................................... 6 
INTERNAL HYPERLINKED CROSS REFERENCES .................................................................................................................................................... 6 
3 DIFFERENT VERSIONS ............................................................................................................................................................................... 6 

PDF Version ....................................................................................................................................................................................... 6 
MS WORD Version ............................................................................................................................................................................. 7 
LOGOS Version .................................................................................................................................................................................. 7 
Book Cover Images ............................................................................................................................................................................ 7 

SIDEBAR NAVIGATION, TOC, & INSTRUCTIONS ................................................................................................................................................ 7 
PDF Instructions ................................................................................................................................................................................ 7 
MS WORD Instructions ...................................................................................................................................................................... 8 
LOGOS Instructions ............................................................................................................................................................................ 8 

PERSONAL BOOKS TOOL (ADD WORD DOCS INTO LOGOS) .................................................................................................................................. 8 
Update Personal Book with changes made in an Existing .docx ....................................................................................................... 9 
Update Personal Book with a new Microsoft Word Source File .docx ............................................................................................... 9 

TOOLBAR & THE LOGOS INTERFACE ................................................................................................................................................ 10 

HOME BUTTON ........................................................................................................................................................................................ 10 
LIBRARY BUTTON ...................................................................................................................................................................................... 10 

Prioritizing Resources & Your Preferred (favorite) Bible .................................................................................................................. 10 
Float the Library & Add Fields (Columns) ........................................................................................................................................ 10 

SEARCH BUTTON ...................................................................................................................................................................................... 11 
COMMAND BOX ....................................................................................................................................................................................... 11 
DOCUMENTS BUTTON ............................................................................................................................................................................... 12 
GUIDES BUTTON ...................................................................................................................................................................................... 12 
TOOLS BUTTON ........................................................................................................................................................................................ 12 

Tools > Copy Bible Verses ................................................................................................................................................................ 12 
SHORTCUTS BAR....................................................................................................................................................................................... 12 
LAYOUTS BUTTON (BOOKS & “DESKTOPS”) ................................................................................................................................................... 12 
CLOSE ALL ............................................................................................................................................................................................... 13 
PROGRAM SETTINGS ................................................................................................................................................................................. 13 
PANEL MENU (RESOURCE MENU) ............................................................................................................................................................... 13 

Copy Location As (Reference Hyperlink) .......................................................................................................................................... 13 

DAILY STUDY & PRAYER HELPS ........................................................................................................................................................ 14 

DAILY READING PLAN: TIMED BOOK OR BIBLE ................................................................................................................................................ 14 
DAILY PRAYER LIST: DAILY PRAYERS ............................................................................................................................................................. 14 

YOUR LIBRARY ................................................................................................................................................................................. 14 

SEARCH LIBRARY ADVANCED (FIND BOOKS) ................................................................................................................................................... 14 
Search Library for Multiple Types of Resources ............................................................................................................................... 14 
Search Logos Directly from Library .................................................................................................................................................. 14 

CUSTOM SEARCHABLE COLLECTION .............................................................................................................................................................. 14 
Bibliography of Your Library ............................................................................................................................................................ 15 
Custom Searchable Collection from Bibliography ........................................................................................................................... 15 

VIEWING RESOURCES ...................................................................................................................................................................... 16 

https://www.logos.com/


 

 W W W . I D E N T I T Y - I N T E L L I G E N C E . O R G  P a g e  |  3 

OPEN REFERENCES IN TOP 5 BIBLES ............................................................................................................................................................. 16 
TRUNCATED RESOURCE TABS & COMMAND BOX ABBREVIATIONS ..................................................................................................................... 16 
SEND HYPERLINKS HERE............................................................................................................................................................................. 17 
VISUAL FILTERS ........................................................................................................................................................................................ 18 
INTERLINEAR BIBLES .................................................................................................................................................................................. 18 

Inline Interlinear .............................................................................................................................................................................. 18 
Interlinear Pane ............................................................................................................................................................................... 18 
Interlinear vs. Reverse Interlinear ................................................................................................................................................... 18 
Using Interlinear in English Bibles ................................................................................................................................................... 19 

NAVIGATION ................................................................................................................................................................................... 20 

FAVORITES & BOOKMARKS ......................................................................................................................................................................... 20 

ORGANIZATION ............................................................................................................................................................................... 21 

LINKING BOOKS (RESOURCES) ..................................................................................................................................................................... 21 
NOTEBOOKS: HIGHLIGHTS & NOTES............................................................................................................................................................. 21 

Notebooks (Documents where Notes & Highlights are Stored) ...................................................................................................... 21 
Notes ............................................................................................................................................................................................... 22 
Highlighting ..................................................................................................................................................................................... 22 
Notes: Adding to Different Notebooks ............................................................................................................................................ 23 
Notebooks: Export Notes and / or Highlights from a Notebook (from a specific resource) ............................................................ 25 

GUIDES & TOOLS ............................................................................................................................................................................. 26 

TABLE: PARTIAL LIST OF GUIDES, TOOLS, & WORKFLOWS .............................................................................................................................. 26 
GUIDES (SOME ADDITIONAL DETAILS) ........................................................................................................................................................... 28 

Using Guides with Linked Resources (Books) .................................................................................................................................. 28 
Atlas Guide (Paid Logos Versions) ................................................................................................................................................... 29 
Bible Word Study Guide ................................................................................................................................................................... 29 
Exegetical Guide .............................................................................................................................................................................. 30 
Passage Guide ................................................................................................................................................................................. 30 
Topic Guide ...................................................................................................................................................................................... 30 

TOOLS .................................................................................................................................................................................................... 31 
Layout Example ............................................................................................................................................................................... 31 
Explorer ........................................................................................................................................................................................... 31 
Factbook .......................................................................................................................................................................................... 32 
Highlighting ..................................................................................................................................................................................... 32 
Information Panel Tool .................................................................................................................................................................... 32 
Notes ............................................................................................................................................................................................... 32 
Text Comparison.............................................................................................................................................................................. 32 

SEARCH & FIND ............................................................................................................................................................................... 33 

FIND NOTES & HIGHLIGHTS ........................................................................................................................................................................ 33 
Find Notes & Highlights via Locator Bar .......................................................................................................................................... 33 
Search for Highlighting .................................................................................................................................................................... 34 
Search for Word with Highlighting .................................................................................................................................................. 34 

BOOLEAN SEARCHES ................................................................................................................................................................................. 35 
CUSTOM GUIDE SEARCH TEMPLATES ............................................................................................................................................................ 35 

Make the Default Guide Search (Home Page) Use Your Template! ................................................................................................ 35 
Use Your Custom Guides to Follow Your Scripture Reading ............................................................................................................ 35 

PERSON SEARCH ....................................................................................................................................................................................... 35 
ADVANCED SEARCHES (FOR PAID VERSIONS OF LOGOS) ................................................................................................................................... 36 

BIBLE TRANSLATIONS COMPARISON TABLE .................................................................................................................................... 37 

https://www.identity-intelligence.org/


 

P a g e  |  4 W W W . L O G O S . C O M   

BIBLE VERSION COMPARISON DIAGRAM ....................................................................................................................................................... 38 

TRICKS & SHORTCUTS ...................................................................................................................................................................... 39 

COMMAND BOX COMMANDS ..................................................................................................................................................................... 39 
COMMAND SEARCHES ............................................................................................................................................................................... 39 
LEGEND OF ALL LOGOS SHORTCUTS ............................................................................................................................................................. 40 
GREAT KEYBOARD SHORTCUTS .................................................................................................................................................................... 40 

[SHIFT] + [CLICK] Toolbar Shortcut .................................................................................................................................................. 40 
[F7] INSTANT PARALLEL BIBLES - Instant Pop-Up of 5 Favorite Bible Versions ............................................................................... 40 
[F11] FULL SCREEN Book / FLOAT Book ........................................................................................................................................... 40 
[F8] [ESC] DRAWING MODE (Markup) ............................................................................................................................................ 40 
[CTRL]+[SHIFT]+[F] SEARCH INLINE ................................................................................................................................................. 40 
[CTRL]+[SHIFT]+[W] CLOSE ALL Panels ............................................................................................................................................ 40 
[Lt / Rt] PARALLEL RESOURCES ........................................................................................................................................................ 40 

ALL KEYBOARD SHORTCUTS ........................................................................................................................................................................ 41 
VIEW Keyboard Shortcuts ................................................................................................................................................................ 41 
NAVIGATION Keyboard Shortcuts ................................................................................................................................................... 41 
TAB Keyboard Shortcuts .................................................................................................................................................................. 42 
INTERFACE Keyboard Shortcuts ....................................................................................................................................................... 42 

INDUCTIVE BIBLE STUDY (MATTHEW 4:11-12) ................................................................................................................................. 42 

PART A: OBSERVATION ........................................................................................................................................................................ 42 
STEP 1: READ the passage in its context SEVERAL TIMES ................................................................................................................ 42 
STEP 2: Identify Important Themes and Connect to Broad Themes of the Bible ............................................................................. 43 
STEP 3: Compare Bible Translations ................................................................................................................................................ 44 
STEP 4a: Explore Context: LITERARY ................................................................................................................................................ 44 
STEP 4b: Explore Context INTERTEXTUAL ........................................................................................................................................ 45 
STEP 5a: Explore Context HISTORICAL ............................................................................................................................................. 45 
STEP 5b: Explore Context CULTURAL ............................................................................................................................................... 47 
STEP 6a: Explore Characters: ACTION ............................................................................................................................................. 47 
STEP 6b: Explore Characters: WORDS ............................................................................................................................................. 48 

PART B: INTERPRETATION .................................................................................................................................................................... 49 
STEP 7a: Study IMPORTANT WORDS & CONNECT them to the rest of SCRIPTURE ......................................................................... 49 
STEP 7b: Study IMPORTANT PHRASES & CONNECT them to the rest of SCRIPTURE ....................................................................... 50 
Research Words in the Original Languages ..................................................................................................................................... 52 

LEFTOFFHERE ....................................................................................................................................................................................... 55 
Understand the PURPOSE IN STRUCTURE ....................................................................................................................................... 55 
Summarize the BIG IDEA of the Text ............................................................................................................................................... 56 
Check COMMENTARIES for INTERPRETATION ................................................................................................................................. 56 
Explore the DOCTRINAL IMPLICATIONS of the Passage .................................................................................................................. 56 

PART C: APPLICATION .......................................................................................................................................................................... 56 
Apply the Passage ........................................................................................................................................................................... 56 
Find Personal Application ................................................................................................................................................................ 56 
Share Insight .................................................................................................................................................................................... 56 

MISCELLANEOUS ............................................................................................................................................................................. 56 

AVANCED SEARCHING HELP ........................................................................................................................................................................ 56 
HIDDEN BOOKS (REMOVING / DELETING RESOURCES FROM LIBRARY) ................................................................................................................ 56 
LOGON AS DIFFERENT USER [CTRL+CLICK DESKTOP ICON]................................................................................................................................ 56 
RESOURCE PATHS ON PC / DELETING PERSONAL BOOKS .................................................................................................................................. 56 

GREEK TOOLS .................................................................................................................................................................................. 56 

GREEK ALPHABET TYPING - WINDOWS SYSTEM KEYBOARD ............................................................................................................................... 56 

https://www.logos.com/


 

 W W W . I D E N T I T Y - I N T E L L I G E N C E . O R G  P a g e  |  5 

Installing Windows Greek Font Set & Keyboard .............................................................................................................................. 56 
Typing in Greek with Windows On-Screen Keyboard ...................................................................................................................... 57 
Typing in Greek with a Hard Keyboard (Polytonic Diacritical Marks).............................................................................................. 57 

URLS TO LOGOS “STUFF” ................................................................................................................................................................. 58 

MISCELLANEOUS ...................................................................................................................................................................................... 58 
URLS TO FREEBIES 1 .............................................................................................................................................................................. 58 
URLS TO FREEBIES 2 .............................................................................................................................................................................. 59 

VIDEO COLLECTION ......................................................................................................................................................................... 59 
DIGITAL TOOLS ................................................................................................................................................................................ 59 
BOOK COLLECTION (ENGLISH) ......................................................................................................................................................... 59 
BOOK COLLECTION (FOREIGN OR MIXED ENGLISH) ........................................................................................................................ 62 

MANUAL UPDATE AND VERSION HISTORY ...................................................................................................................................... 64 

UPDATED MANUALS & FORUMS FOR LOGOS BOOK COVERS ............................................................................................................................. 65 

  

https://www.identity-intelligence.org/


 

P a g e  |  6 W W W . L O G O S . C O M   

Copyright Notice 
Logos is a masterful and fearful tool – its breadth is such that it is simple enough for computer novices and newbies to 
Christianity – yet its depth is significant enough that scholars and theologians utilize it. Logos can be an amazing 
resource to empower Christian business owners to minister to their families, neighbors, employees, colleagues and 
clients. It is a tool that can be used in apologetics and evangelism – people are blown away when they realize just how 
significant the history of Christianity is; Logos opens a world of wonder. The possibilities of God using Logos, as an 
instrument in your hands – to do His will and use your “talents’ – is vast and significant. I encourage the open source 
usage, editing, dissemination, and innovation of this manual, in any way you see fit, and in any way you prayerfully feel 
led. 

FREE RESOURCES 

Get LOGOS for FREE! $1,500 Value 
https://www.logos.com/basic 
https://support.logos.com/hc/en-us/articles/360019103211-Logos-Feature-Training-Videos 
https://support.logos.com/hc/en-us/articles/360053103931-Logos-Mobile-Training-Videos 

Get FREE Books & Resources 
See the section at the end of the manual: URLs to FREEBIES 1 

iDENTITY iNTELLIGENCE Logos Group 
 LOGOS WEB APP - https://app.logos.com/ 
 LOGOS ii GROUP - https://faithlife.com/identity-intelligence 
 LOGOS ii DOCS - https://faithlife.com/identity-intelligence/documents 

 

HOW TO USE THIS MANUAL 

Updates and Version History 
 Please post any questions or comments here: https://community.logos.com/forums/t/182780.aspx 
 All 3 Manuals will always be identical except that there is a version for: 1) PDF 2) WORD 3) LOGOS 
 You can look at the version history at the end of the manual (cf. Manual Update and Version History) 

Internal Hyperlinked Cross References 
This manual contains many Internal Hyperlinks (i.e. cross-references) that link to other places in this manual; 
unfortunately, these hyperlinks WILL NOT work when this manual is imported into Logos. However, each red hyperlink is 
the name of a Header – so it can easily be found using the sidebar, table of contents, or by executing a “Find” 

3 Different Versions 
There are three versions of this manual; these links are dynamic and I will regularly be posting updated versions of the 
manual which can be accessed using these same URLs: 

PDF Version 
For use as a Portable File .PDF (with a Table of Contents) 
www.identity-intelligence.org/content/logos-manual-toc.pdf 

https://www.logos.com/
https://www.logos.com/basic
https://support.logos.com/hc/en-us/articles/360019103211-Logos-Feature-Training-Videos
https://app.logos.com/
https://faithlife.com/identity-intelligence
https://faithlife.com/identity-intelligence/documents
https://community.logos.com/forums/t/182780.aspx
http://www.identity-intelligence.org/content/logos-manual-toc.pdf
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MS WORD Version 
For use in Microsoft Word (with a Table of Contents) 
www.identity-intelligence.org/content/logos-manual-toc.docx 

LOGOS Version 
For Import into Logos (without Table of Contents) 
www.identity-intelligence.org/content/logos-manual.docx 

Book Cover Images 
https://community.logos.com/forums/p/182780/1057871.aspx#1057871 
 

Sidebar Navigation, TOC, & Instructions 
All manuals have sidebar navigation; cf. instructions below. 

PDF Instructions 
In your PDF editor / viewer, turn on BOOKMARKS; the .pdf version will always be bookmark indexed. The PDF version 
has a major ADVANTAGE & DISADVANTAGE – ADVANTAGE: If you open the PDF in a web browser (e.g. Google Chrome) 

– you can [CTRL] + [CLICK] any hyperlink to open it in a New Tab. So if you’re using the manual and see a cross-
reference to something else in the manual, you can open it in a New Tab – thus you don’t lose your place in the manual. 
DISADVANTAGE: While web browsers like Chrome give you access to the bookmarks (Table of Contents) – I don’t know 
of a way to open the Table of Contents (PDF Bookmarks) as a Sidebar (all PDF editors / readers have this ability – I don’t 
know if any web browsers do). This screenshot is from Google Chrome: 

 
  

https://www.identity-intelligence.org/
http://www.identity-intelligence.org/content/logos-manual-toc.docx
http://www.identity-intelligence.org/content/logos-manual.docx
https://community.logos.com/forums/p/182780/1057871.aspx#1057871
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MS WORD Instructions 
Microsoft Word > [CTRL] + [F] (this brings up your Navigation Pane in Word) then click on “HEADINGS” – this will 

give you a sidebar Table of Contents that is always visible as you scroll through the manual. If you RIGHT-CLICK any 

HEADING you will have other features: 

 

LOGOS Instructions 
A sidebar TOC (Table of Contents) will be auto created when importing the Logos Version of the manual (cf.  
Personal Books Tool (add Word Docs into Logos)). 

Personal Books Tool (add Word Docs into Logos) 
https://wiki.logos.com/personal_books#Uploading_and_Deleting_books 
 
IMPORTANT NOTES: 

 The Word files must be a .docx file (if you have an old .doc you must convert it in Word first) 
 Decide carefully where you will put that file; Logos will remember the file name and location -- and if you make any 
edits / updates to the Word .docx later, you can instantly rebuild it in Logos 

 So, for example, I’ll periodically update this manual; you can replace the old one with the newer version, then just 
update it in Logos 

 

https://www.logos.com/
https://wiki.logos.com/personal_books#Uploading_and_Deleting_books
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TOOLS > PERSONAL BOOKS > ADD BOOK 

 
 

 INFORMATION - Fill out Title and Author (USE YOUR NAME FOR AUTHOR -- so you can find your personal 
books easy later -- by searching for author in the library or command bar). 

 UPLOAD BOOK COVER - Under the image of the gray blank book cover, click "CHANGE..." and upload the book 
cover image 

 UPLOAD BOOK - Click "ADD FILE..." > Navigate to your .docx book file and upload it 

 BUILD BOOK - Click "BUILD BOOK" > Click "FINISHED" 
 UPLOAD BOOK - After you finish, hover over your book and click the arrow that pops up to the right of the book. 

Choose “EDIT” > “UPLOAD” … now your book should be available on all your devices – and on the online version 
of Logos 

Update Personal Book with changes made in an Existing .docx 
 Make sure the new version is in the same folder with the same name as the original TOOLS > PERSONAL 

BOOKS >CLICK BOOK > “BUILD BOOK” 

Problems Rebuilding A Personal Book 
Updated (rebuilding) a Personal Book can be a bit buggy sometimes. Generally, these two things should ensure that 
rebuilding a book goes well: 
1) Be connected to the internet 
2) Close and reopen Logos before rebuilding a Personal Book 
 

Rebuilding - File Renaming Strategy 
1) Rename the old file (e.g. "logos-manual-20190725.docx") 
2) Then put the newly downloaded version (i.e. logos-manual.docx) in the same directory 

3) BUILD BOOK using the instructions above 
 

Update Personal Book with a new Microsoft Word Source File .docx 
 If you rename the source file, move the source file to a different directory, or create a new source file, you will 
have to DELETE the original reference to that source file in the Logos Personal Books Tool 

https://www.identity-intelligence.org/
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TOOLBAR & THE LOGOS INTERFACE 

Home Button 

 
 Toggles between “LOGOS Cloud” and Your Logos Library System 

Library Button 

 

Prioritizing Resources & Your Preferred (favorite) Bible 
 Open the LIBRARY > choose your favorite books > RIGHT-CLICK > “PRIORITIZE THIS RESOURCE” 
 The Prioritized Resources will show up first in any searches. The 1st bible will be your PREFERRED BIBLE (the bible 
that pops up when you hover over a verse reference).  

 When choosing your top 5 bibles, I recommend you consider how Literal it is, and the Grade Reading Level. You can 
get help on this here: BIBLE TRANSLATIONS COMPARISON 

Float the Library & Add Fields (Columns) 

 
 Click LIBRARY Button > Click “OPEN FLOATING WINDOW” Button 

 Click LIBRARY Button > RIGHT-CLICK the FIELDS Header (e.g. Type or Title) 
 

https://www.logos.com/
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Search Button 

 
Let’s do an in depth study on the concept of “work” in Jesus’ words: 

 Click the SEARCH Button 

 Choose “BIBLE” Tab 

 Change “All Passages” to “GOSPELS” 

 Change “Top Bibles” to “LEXHAM” 

 Type in “WORK” 

 When the results appear Click on “ALIGNED” to view more easily 
 Mt 20:12 seems to be speaking about “work” in a sense relating to laboring 

 Click “WORK” in Mt 20:12 and it will open that verse in the bible the word was found in. 

Command Box 

 
 Type the name of any resource (book) - e.g. “STUDY” 

 Type the name of any resource (book) type (e.g. “BIBLE” or “DICTIONARY”) 

 Type the name of any resource (book) abbreviation (e.g. LEB, LBD, etc) 
 
NOTE: You can view the abbreviations in the library. 
To learn how to add Fields (Columns) to the library view, cf. Library Button 

 
 

 Type the name of any topic (e.g. “PRAYER” or “FASTING”) 

 Type the name of any command (e.g. “CLOSE ALL”) 
 For a list of Command Box COMMAND SHORTCUTS cf. Command Box 

https://www.identity-intelligence.org/
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Documents Button 

 
This is where all your personal files will be stored. Many of these (Notebooks, Reading Plans, etc) will be explained later 
in this manual. 

Guides Button 

 
This is where you will find all Logos’ Guides to help you find / search for things in your library. 

Tools Button 

 
There are many powerful tools here; many of these will be explained later in this manual. 

Tools > Copy Bible Verses 
 Copy all your verses in any bible version you like / any format you like / and paste into any program 

Shortcuts Bar 

 
 Drag anything onto the shortcuts bar (e.g. CLOSE ALL or the KJV Bible) Anything that comes up in the command 
box can be dragged onto the shortcuts bar. 

 Drag From Anywhere – E.g. 1) If you had the Favorites Tool open (Tools > Favorites) you could drag the Title Bar 
(with the Star Icon) to the shortcuts area. 2) If you typed “Favorites” in the Command Box one of the results would 
be the Favorites Tool – you could drag that to the Shortcuts Bar. 3) If you went to the Tools Menu and typed 
“Favorites” – you could drag that to the shortcuts bar. 

 Shortcut to External File - To put a Shortcut to an external file or program: TOOLS > FAVORITES > DRAG 

FROM WINDOWS EXPLORER to Favorites > DRAG FROM FAVORITES PANE > TO SHORTCUT BAR 

TIP: [SHIFT] + [CLICK] any shortcut and resource or tool will open as a Floating Panel! 

Layouts Button (Books & “Desktops”) 

 
SAVE AS NAMED LAYOUT 

 You can save any current desktop (i.e. LAYOUT) 
 You can name it anything you like 
 You can have unlimited LAYOUTS 

https://www.logos.com/
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 The Layout Saves EVERYTHING (Books that are open, other open Resources (e.g. Favorites Panel, Notes Document, 
Highlighting Tool, etc), the page they are open to, their Link Sets, even the font size. Everything. 

 
UPDATE (SAVE) EXISTING LAYOUT 

 If you change the LAYOUT, and mess it up, you can just reopen it back to the saved version anytime. Also, you can 
update an existing layout, you can resave it with the new changes. 

Close All 

 
 Start with a Brand New blank Desktop 

Program Settings 

 

Panel Menu (Resource Menu) 

 
 Any resource that is open (e.g. a book, course, video, information panel, search guide, etc) will have a Panel Menu 
with contextual options (e.g. extra features, font size of that window/resource, etc). 

Copy Location As (Reference Hyperlink) 
 PANEL MENU > COPY LOCATION AS This is one of the great tools you can access in the Panel Menu 
 Copy a link to just about any Book (Resource) in your library to: A) Share with others who own logos, through email 
or text B) Share with yourself (e.g. in a word document) 

 
 

https://www.identity-intelligence.org/
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DAILY STUDY & PRAYER HELPS 

Daily Reading Plan: Timed Book or Bible 
 DOCUMENTS > READING PLAN > Choose what part of bible you want to read / how often / how many days 
 NOTE: Consider having a Notebook just for this or all reading plans! E.g. “DEVOTIONAL NOTES” or “JOURNAL” 
 Learn more about notebooks cf. Notebooks: Highlights & Notes 

Daily Prayer List: Daily Prayers 
 DOCUMENTS > PRAYER LIST > Choose days / frequency / etc 

YOUR LIBRARY 

 

Search Library Advanced (Find Books) 

 
 “CALVIN” will show all books WRITTEN by him and containing QUOTATIONS from him 

 “AUTHOR:CALVIN” will show just books written by him 

 “TYPE:ENCYCLOPEDIA” – Show all bible dictionaries / encyclopedias | “type:bible” “type:commentary” 

 “TYPE:BIBLE AND LANGUAGE:ENGLISH” 

 RIGHT-CLICK that HEADER ROW of the Library Database to add more Fields (e.g. Title, Author, Rating, Series, 
etc)to Sort / Filter by. ABBREVIATIONS – you can show the abbreviations field and if you know the abbreviation for 

a book, you can type that in the GO BAR or the LIBRARY SEARCH BAR; e.g. for the Faithlife Study Bible, it’s “FSB” 

Search Library for Multiple Types of Resources 
 TYPE:MAGAZINE,MONOGRAPH,JOURNAL 

 Abbreviations are advised (because there are some types that are similar in name but a little different): 

TYPE:COMMENT,MAGAZINE,MONO,JOURNAL,THEOLOGY,COURSE,MEDIA 

Search Logos Directly from Library 
After doing a resource search (e.g. TYPE:MAGAZINE,MONOGRAPH,JOURNAL) > SELECT RESOURCES you want 

to search > RIGHT-CLICK > “SEARCH THESE RESOURCES” 

Custom Searchable Collection 
 TOOLS > COLLECTIONS > (name it and give it a RULE; e.g. TYPE:magazine,monograph,journal) 

https://www.logos.com/
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 FYI: When you “Search” you can choose to search from a collection of books that you created (e.g. your favorite 
commentaries, favorite bibles, etc). 

 FYI: These collections can also be used in creating a CUSTOM GUIDE which you can learn about here: Custom Guide 
Search Templates 

 TO OPEN A COLLECTION: DOCS > RESOURCE COLLECTION 

Bibliography of Your Library 

 
DOCS > NEW > BIBLIOGRAPHY > ADD > A COLLECTION 

Custom Searchable Collection from Bibliography 

 
 DOCUMENTS > BIBLIOGRAPHY (open a bibliography you created) > SETTINGS (i.e. Panel Menu) > SAVE AS 

COLLECTION  

https://www.identity-intelligence.org/
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VIEWING RESOURCES 

Open References in Top 5 Bibles 
You can instantly open any bible reference in one of your top 5 bibles (cf. Prioritizing Resources & Your Preferred 
(favorite) Bible): 

 

Truncated Resource Tabs & Command Box Abbreviations 
Every resource can have an abbreviation (e.g. Lexham English Bible = LEB). Abbreviations serve multiple purposes: 
A) TAB TITLES - When multiple panes are open, Logos automatically starts to abbreviate the Titles on the Tabs. You can 
control what the abbreviation is. Also, you can force abbreviated tabs even when there’s only a few tabs open. 
B) COMMAND BOX - When using the Command Box you can just type the Abbreviation for Searches. 
 

You can control / edit both A & B. OPEN A RESOURCE (book, course, etc) and do the following: 
 

 
 

https://www.logos.com/


 

 W W W . I D E N T I T Y - I N T E L L I G E N C E . O R G  P a g e  |  17 

 

Send Hyperlinks Here 
TWO PREFERRED BIBLES? Once you’ve setup your Preferred Bible (cf. Prioritizing Resources & Your Preferred (favorite) 
Bible) - anytime you hover over a verse reference, a pop-up will show that verse in your favorite (Preferred) bible. But, if 
you click that verse reference, it will open that verse in your preferred bible. You may find that redundant. So you can 
set a different bible to Receive All Hyperlinks (when you click on a verse reference, it will open in that bible instead of 
your preferred bible). 
 

 
 

 
 

https://www.identity-intelligence.org/
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Visual Filters 

 
With Visual Filters, you can toggle tons of things on / off (especially in bibles). If you expand “Bible Text Only” you will be 
able to HIDE / SHOW just about anything. 

 VIEW BIBLE AS LITERATURE - Select “Bible text only” and then deselect everything under it (e.g. bible text 
formatting, chapter / verse numbers, etc) – and you will be left with just the bible text (like a book) – pretty great. 

 HIGHLIGHTS / NOTES - You’ll also be able to turn off your notes / highlights, etc 

Interlinear Bibles 

 
 
Some bibles are “tagged” to the original languages (Hebrew, Aramaic, & Greek) – the Lexham English Bible (LEB) is one 
of these. You’ll know if a bible has interlinear, because the interlinear button (pictured above) will only be available if it 
does. 

Inline Interlinear 
 Show the original language right below (inline) the English text (as pictured above) 

Interlinear Pane 
 Opens up a panel on the bottom of the bible; click a word in the bible to see the results in the pane 

Interlinear vs. Reverse Interlinear 

Interlinear 
 LANGUAGE - [An Original Language Bible with English contained within] 
 WORD ORDER - Words ordered by order of original language > English order follows original order 
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 (i.e. generally Greek or Hebrew – but also Aramaic, Latin, Arabic, or German) 
 An interlinear will have the original language written in the order it was written: you can see which words had 
priority of placement (eg, at the beginning of a sentence for emphasis, etc), how the sentence was structured 
originally. 

Reverse Interlinear 
 LANGUAGE - [An English Bible with Original Language contained within] 
 WORD ORDER - Words ordered by order of English > Original language follows English order 
 A reverse interlinear “works backward”. It shows the translated English passage in order, and rearranges the 
original language underneath it, out of order compared to its original state, but tied closely to the translated text so 
we can tell what phrase or word was used to translate the original language. 

Using Interlinear in English Bibles 

 
 Surface - [What you see on the SURFACE] the English word or text 
 MSS – [MANUSCRIPTS] the original language manuscript as the original authors recorded it 

 MSS Trl - [MANUSCRIPTS TRANSLITERATED] the original language word with the letters of the word changed to 
English letters for pronunciation 

 LEMMA – [DICTIONARY FORM] (e.g. ran, runs, running -- as opposed to RUN) the dictionary form of the manuscript 

inflected word. The “inflected form” of a word is what we commonly think of as a word. It is a word as it is used in 
the given context. It is complete with any prefixes and suffixes that may indicate its grammatical function in a given 
sentence. 

 Lemma Trl - [DICTIONARY FORM TRANSLITERATED] the transliteration (pronunciation guide) of the lemma in the 
original language. 

 ROOT – [DICTIONARY ROOT] (e.g. RUN -- as opposed to: ran, runs, running) a base word from which multiple words 

may be derived. 
 Root Trl – [DICTIONARY ROOT TRANSLITERATED] a base word, with the letters of the word changed to English 
letters for pronunciation. 

 MORPH – [MORPHOLOGY] The form of a word is called its morphology. Sometimes you need to know whether a 

word is singular or plural. Or you may need to know whether the tense of a word is past, present, or future. Or you 
may need to know other different meanings of a word. Identifying these differences is discovering the morphology 
of a word. We are looking at the morphology (form) of the word in the original language lemma. When we hover 
over a word and “VPAM2P” pops up -- it means: this word is a verb (V) in the present (P) tense. This is an active (A) 
verb that shows continued or progressive action on the part of the subject. This is an imperative (M) verb used to 
give orders, commands and instructions. It is also a second (2) person verb. In other words, it is a verb that implies 
an action toward the person being talked to. Finally, this verb is a plural (P) verb, one that is an action on more 
than one person. 

 Strong’s – [STRONG'S CONCORDANCE NUMBER] the corresponding Strong’s number for the lemma. “Strong” is an 
abbreviation for the “Strong’s Exhaustive Concordance of the Bible”, or “Strong’s Concordance”. It is a concordance 
of the King James Bible (KJV). The purpose of Strong's Concordance is to provide an index to the Bible. This allows 
the reader to find words where they appear in the Bible. This index allows a student of the Bible to re-find a phrase 
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or passage previously studied. It also lets the reader directly compare how the same word may be used elsewhere 
in the Bible. 

 Louw – [LOUW-NIDA GREEK LEXICON] “Greek-English Lexicon of the New Testament based on Semantic Domains." 
Louw-Nida is a modern Greek lexicon using the concept of "semantic domains." This lexicon differs from other 
lexicons in that it does not arrange words alphabetically and it does not give one listing of a word with all of that 
word's meanings after it. Instead, it breaks words down by their various shades of meaning. It then groups all of 
those entries together and organizes them by topics and sub-topics. It shows the nuances in word meanings and 
explains difficult expressions and idiomatic usages of words, and even provides advice on how words might be 
translated under various conditions. Since it groups words by meanings, it shows distinctions in meaning between 
similar words, and also between differences in one word's meaning in different contexts, as well as showing the 
overlaps between word meanings. 

 Sense – [SENSE = MEANING] the meaning of the word. 

NAVIGATION 

Favorites & Bookmarks 

 

Favorites 
Recommended Use: For long-term shortcuts you plan on keeping. 

 TOOLS > FAVORITES 

 FYI: Like anything else in Logos, you can also drag the Favorites (Star Icon) to the Shortcuts Bar (cf. Shortcuts Bar).  

 CLICK ON THE BOOK (make that pane active) you want as a Favorite (to the page and paragraph you want to 

access later) > in Favorites Tool > “ADD” 

 CREATE A FOLDER / DELETE A FAVORITE / SORT - RIGHT-CLICK ANY FAVORITE 

Bookmarks 
(found at the Bottom of the Favorites Tool)  
Recommended Use: For short-term shortcuts you plan on changing. 

 TOOLS > FAVORITES 

 SET BOOKMARK - SHORTCUT: [CTRL] + [SHIFT] + [#] 

 GOTO BOOKMARK - SHORTCUT: [CTRL] + [#] 
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 DELETE A BOOKMARK > HOVER Over it > CLICK “X” (a little x appears on the right when hovering over a 
favorite) 

ORGANIZATION 

Linking Books (Resources) 

 
 In Logos you can open any books in any way you like, and you can link them so they follow each other. 
 You can have dictionaries linked to each other so as you search for a word in one, another(s) will auto follow. 
 You can have bibles and commentaries linked so if you go to John 1:1 in one of them, all the other linked books will 
follow. 

 You may want to set your open bibles and commentaries to Link Set A and your dictionaries to Link Set B. 

 PANEL SETTINGS (3 dots on upper right corner of an open book) > CLICK LINK (e.g. A, B, C, etc) 

Notebooks: Highlights & Notes 

 

Notebooks (Documents where Notes & Highlights are Stored) 
 TOOLS > NOTES Notebooks are odd in a few ways; for one, though the Notes Tool (your notebooks) are found at 
Tools > Notes – the personal notebooks you create will be found here DOCS > “YOUR NOTEBOOK NAME”. With any 
other ‘doc’ – to create a new one, you go DOCS > NEW; but not to create a new notebook, you must open the 
TOOLS > NOTES. When you open the Notes Tool, every single notebook is opening… sort of… 
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Notes 
• TOOLS > NOTES > SELECT NOTEBOOK that you want to add a Note to 

• Goto any book > SELECT THE TEXT you want to add a note to > RIGHT-CLICK > Choose your selection (e.g. 

Reference, Text, etc) > ADD A NOTE TO ‘YOUR NOTEBOOK’ – it’s intuitively obvious where that note will 
be stored. However…. 

Highlighting 
 TOOLS > HIGHLIGHTING 

 When you select text and then apply a highlighting style – that highlighting will be stored in whatever notebook is 
currently active. It’s very easy to accidentally store the highlighting in the wrong Notebook which can be very 
frustrating on many levels (organization, future searching, etc) 

 SELECT TEXT in any book > CLICK YOUR HIGHLIGHTING STYLE in the Highlighting Tool! 
 NOTE: For the “INDUCTIVE/PRECEPT” Palette, Logos uses Kay Arthur’s Inductive Method 

Duplicate Highlighting Palette 

 

Edit, Delete, & Rename Highlights 
IMPORTANT NOTE: I recommend that you don’t edit Logos’ built in Palettes or Highlights. Instead, duplicate an entire 
palette and then go in and delete those you don’t want – and edit others (change the styles, rename, etc) 
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Notes: Adding to Different Notebooks 

 
You may want to work with multiple Notebooks, so that when you right-click something in a book, you can add easily 
add Notes to different Notebooks. You can always go to the Notes Tool, change the Active Notebook, and then when 
you Right-Click text in a book, that Notebook will be available to “Add a Note to ‘NOTEBOOK NAME’” – but that is very 
cumbersome if you are regularly adding Notes to different Notebooks. 
 

https://www.identity-intelligence.org/


 

P a g e  |  24 W W W . L O G O S . C O M   
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Notebooks: Export Notes and / or Highlights from a Notebook (from a specific resource) 
OPEN DESIRED NOTEBOOK > FILTER (by resource) > SORT (by Resource if you want your notes to be in the same 

order as the resource) > SELECT ALL NOTES > PRINT/EXPORT 
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GUIDES & TOOLS 

TABLE: Partial List of Guides, Tools, & Workflows 
The following tables are a partial list of some of the Guides, Tools, and Workflows. All of those listed below are 
contained within the Logos 9 Starter Package (the cheapest package). 
 
Regarding the column labeled "Can add to Custom Guides", cf. Custom Guide Search Templates 
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Guides (some additional details) 

Using Guides with Linked Resources (Books) 
 NOTE: With all guides, you can expand / collapse the results using the little arrows to the left of each section 
 When you have a book(s) Linked to the Guide (cf. Linking Books (Resources) ) – the guide will not keep searching 
for the items whose arrows are collapsed 

 This can speed up your experience and then just expand the sections you want, when you want 
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 NOTE: The resources will be sorted in the order in which you Prioritized your Resources (cf.Prioritizing Resources & 
Your Preferred (favorite) Bible) 

 

Atlas Guide (Paid Logos Versions) 
 SEARCH - You can type subjects or verse references in the upper left 

 DISTANCES - You can [CTRL] + CLICK & DRAG to measure distances 
 LEGEND is in Upper Left 
 RELATED EVENTS – The Map Legend (scroll down) also includes links to related events 

 MODERN MAP - To see modern map RESOURCE SETTINGS (3 vertical dots) > “OPEN GOOGLE MAPS” 

Bible Word Study Guide 

 
 Greek (or Hebrew) Word Study 
 Let’s learn some things about the word “work” that Jesus used in Mt 20:12 
 Pay close attention to the Greek word (i.e. Lemma) which is ποιέω 

 RIGHT-CLICK “WORK” > and choose “BIBLE WORD STUDY” (i.e. EXEGESIS) 

 Now look for ποιέω and CLICK ON IT’S RING (or the word ποιέω)  
 This is the ONLY VERSE where Jesus uses this word!!!! 

Graph Bible Searches 

 
Let’s look at every place in the LEXHAM Bible where “work” is used  

 Click on GRAPH BIBLE SEARCH 
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Exegetical Guide 
Sections that are more scholarly such as textual variance, grammars, visualizations, and word-by-word section that gives 
detailed info on each word in the original language. 

Passage Guide 
 Passage guide will give a full report about context, background, structure, and key elements of a biblical passage. 
 Cross References Section gives passages that Scholars believe are connected in some way. 
 Literary Typing Section tells us what Literary Genre the passage falls into 
 Cultural Concepts Section tells us differences between our culture and the culture of the original audience 

Interesting Words Section (Passage Guide) 

 
 This Graphic was created using the Interesting Words Section 
 The bigger the word, the more often is occurs in the pericope 

 GUIDES > PASSAGE GUIDE > “ADD” (top right corner of the guide) > INTERESTING WORDS > TYPE 

YOUR SCRIPTURE REFERENCE > ENTER > EXPAND “INTERESTING WORDS” SECTION 

 BIG = HIGH FREQUENCY - A graphical representation of the words in a section of scripture, arranged by frequency 
(the large the word, the more times it is used). 

 ENGLISH <-> GREEK/HEBREW - We can easily toggle between English and the original language. 
 VERSE REFERENCE? What should you type in for the pericope (section) of scripture?  Consult trusted commentaries 
to see how the commentators separated the sections (e.g. many commentaries break Jesus’ Temptation to 
Matthew 4:1-11 

Topic Guide 
 Let’s say you were studying Matthew 4:1-11 and you noticed the theme of TEMPTATION, and you wanted to see 
how this Theme fits into the overall Biblical Theme.  

 GUIDES > TOPIC GUIDE > type in “TEMPTATION” and wait for the results to populate. You will probably see 
“Temptation Topic” and “Temptation of Jesus” Topic. Since Matthew is talking about the Temptation of Jesus, go 
ahead and choose that and watch the guide populate itself. 

 TOPIC SECTION: You’ll note that one of the Sections in the Topic Guide is, Topic. Now you’ll see every resource in 
your library that deals with the Topic of “Temptation of Jesus” 
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Tools 

Layout Example 
I find that I almost always keep these 7 phenomenal tools open – here’s an example layout: 
Column 1: NOTES 
Column 2: EXPLORER | FAVORITES 
Column 3: TEXT COMPARISON 
Column 4: INFORMATION | POWER LOOKUP | HIGHLIGHTING 

 

Explorer 
 NOTE: For a cool sample of this tool in action, cf. Explore the Physical Setting with the EXPLORER TOOL 
 Explorer retrieves a variety of interesting data on the current Bible passage and can be linked to follow along with 
Bible reading to provide additional information (it will explore with you as you move through your bible and / or 
commentary). 

 For more on linking resources (books) cf. Linking Books (Resources) 
 
To Use the Explorer Tool: 

METHOD 1 - TOOLS > EXPLORER > ENTER BIBLE REFERENCE (e.g. John 1:1) > ENTER (or choose a pericope and 
passage from the suggested matches). 
 

METHOD 2 - RIGHT-CLICK A WORD in the Bible > SELECT THE BIBLICAL REFERENCE (e.g. John 1:1) in the right 

pane > select EXPLORER in the left pane 
 
THEN... 

 Click a People, Places, or Things link to open the FACTBOOK. 
 Click a Media link to open the items mentioned in step 3 above, or an image from 1000 Bible Images or similar 
resource, or a map from the Logos Deluxe Map Set. 

 Click a My Content link to open a previously created document. 
 Click a Cross Reference link to open the preferred Bible to a related passage. 
 Click a Commentaries link to open a commentary to the passage. 
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Fun Explorer Tool Sample Exercise 

 Go into any BIBLE > TYPE “NOAH” in the Reference Search Box (top left corner of the bible) 

 DON’T HIT ENTER or the GO Arrow! 

 Instead, after it populates results, > CLICK “NOAH AND THE FLOOD” 

 In Genesis 7:1, RIGHT-CLICK “ARK” (or any word in Gen 7:1) > SELECT “GENESIS 7:1” in the right column > 

SELECT “EXPLORER” in the left column > in the Explorer Tool Panel > Select “NOAH’S ARK” > under the 

Library Results Section click > BY RESOURCE > Click FAITHLIFE STUDY BIBLE INFOGRAPHICS 

Factbook 
 TOOLS > FACTBOOK (also comes up automatically in the in the Topic Section of the Topic Guide) 

Highlighting 
 Cf. Notebooks: Highlights & Notes 

Information Panel Tool 
 TOOLS > INFORMATION 

 Hover over any word in a bible to get great information about that word 
 DISABLE HOVER - If you would like to always keep the Information Tool open (which I highly recommend) – it may 
be annoying that it constantly updates as you hover over your books. You can change it to activate via mouse click: 

PANEL MENU > UPDATE ON > CLICK: 

 

Notes 
 Cf. Notebooks: Highlights & Notes 

Text Comparison 
 TOOLS > TEXT COMPARISON TOOL 

 Definitely may want to use it as a Floating Panel (cf. FULL SCREEN Book / FLOAT Book) especially if you want to 
have a lot of bibles open. Also, a neat trick is to have Instant Parallel Bibles (cf. INSTANT PARALLEL BIBLES) 

 You can change which bibles and the order of the bibles (it’s a little tricky to figure out at first but if you want help 

at any time in Logos, just hit your [F1] key on the keyboard. Logos has some of the best help files I’ve ever seen. 
 The First Bible is the MAIN VERSION and every other version is compared to this one 

 

 Use this button to turn on the text (in a Blue Font) that IS NOT in the MAIN VERSION (but is in the other version) 
 

 Use this button to turn on the text (strikethrough) that IS in the MAIN VERSION (but not the other versions) 
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SEARCH & FIND 

Find Notes & Highlights 

Find Notes & Highlights via Locator Bar 
First, open up the Locator Bar in your book’s Panel Menu: 

 
 
Now, change the Locator Bar’s Find Tool to “ANNOTATION” and use the UP/DN Arrows: 
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Search for Highlighting 
First open the Inline Search in your book’s Panel Menu: 

 

Search for Word with Highlighting 
Find all Orange Highlighting with the word “meditation” 

 

Advanced Searching in Highlighting 

 
https://wiki.logos.com/Search_HELP#Highlighting 

https://www.logos.com/
https://wiki.logos.com/Search_HELP#Highlighting


 

 W W W . I D E N T I T Y - I N T E L L I G E N C E . O R G  P a g e  |  35 

Searching Highlight Styles 
{Highlight *} = all highlights 
{Highlight Blue} = Blue style 
Lord WITHIN {Highlight Blue} = word within highlight 
“Jesus Christ” WITHIN {Highlight Blue} = phrase within highlight 

Searching Highlight Palettes 
{Highlight Solid Colors/*} = all styles in the Solid Colors palette 
{Highlight PaletteName/StyleName} = if multiple palettes have style with same name 

Searching Highlight Palettes with “/” 
Use quotes if palettes or styles contain a slash in the name: 
{Highlight Highlighter Pens/Orange Highlighter} = ‘Orange Highlighter’ style from ‘Highlighter Pens’ palette 
{Highlight Highlighter Pens/“Orange/Highlighter”} = ‘Orange/Highlighter’ style from ‘Highlighter Pens’ palette 

Boolean Searches 
 Logical Operators: AND, OR, ANDNOT 
 Sequence Operators: BEFORE, AFTER, WITHIN, ANDEQUALS, NOTEQUALS 
 Proximity Operators: BEFORE n, AFTER n, WITHIN n, NEAR 
 E.g.: love BEFORE "the world" 
 E.g.: pray* NEAR fast* 

Custom Guide Search Templates 
 GUIDES > NEW (Bottom Right Corner) > MAKE A NEW GUIDE (or: TOOLS > GUIDE EDITOR) 
 Name it 
 Choose the “Kind” 
 Click on the aspects (right side) you’d like in it 

Make the Default Guide Search (Home Page) Use Your Template! 
Create your perfect guide template and name it “My Passage Guide” and now you’ll get lightning fast searches on only 
the resources you want. 

Use Your Custom Guides to Follow Your Scripture Reading 
Simply open your custom guide (GUIDES > CUSTOM GUIDES) and Link it to your bible! Cf. Linking Books (Resources) 
It will follow you wherever you go :o) 

Person Search 
 In Matthew 4:3 > RIGHT-CLICK “TEMPTER” > select LEMMA (hover over the original languages and you’ll see 

root, lemma, etc) > SEARCH THIS RESOURCE INLINE 
 You’ll find that most results are words such as tempted, tempter, test, testing, etc – but in the context you’ll also 
see words like “devil” and “satan” 

 Go to those verses and then start the process all over (e.g. RIGHT-CLICK “DEVIL” > LEMMA > SEARCH THIS 

RESOURCE INLINE 
 Depending on the Logos package you have, you may have a very powerful tool that will find every occurrence of 
every word associated with “tempter”: 

 In Matthew 4:3 > RIGHT-CLICK TEMPTER > SATAN PERSON > SELECT SEARCH THIS RESOURCE INLINE 

 Also search (with paid version of Logos): <PERSON SATAN> NEAR <PERSON JESUS> 
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Advanced Searches (for Paid Versions of Logos) 
 pray* WITHIN {Type <Bible Commentary>} 
 pray* WITHIN {Section <Culture Fasting>} 
 <Person Satan> NEAR <Person Jesus> 
 bread WITHIN {Speaker <Person Jesus>} (Find any biblical topic spoken of by any biblical person) 
 {Addressee <Person Satan>} Every time Satan is addressed 
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BIBLE TRANSLATIONS COMPARISON TABLE 

 

https://www.identity-intelligence.org/


Bible Version Comparison Diagram 



TRICKS & SHORTCUTS 

Command Box Commands 
Commands are not case-sensitive, so home and Home and HOME are equivalent. Type the following right into the 
Command Box and hit enter (or wait for it to populate potential actions)… 
 

 CLOSE ALL WINDOWS: CLOSE ALL 

 COPY MT4.1-11 (preferred bible) 

 COPY MT4.1-11 FROM LEB 

 COPY MT4.1-11 IN LEB 
 

Add "IN NEW WINDOW" to any of the following if desired: 

 Open VERSE in PREFERRED BIBLE: MT4.1 

 Open VERSE in OTHER BIBLE: NIV TO MT4.1 

 Lookup HEADWORD in TOP RESOURCE: LOOKUP ANGELS 

 open SPECIFIC DICTIONARY to HEADWORD: OPEN LBD TO ANGELS 

 OPEN GUIDE: PASSAGE GUIDE TO MT4.1 

 OPEN GUIDE: TOPIC GUIDE TO TEMPTATION 

 OPEN GUIDE: BIBLE WORD STUDY TO HONOR 

 DOCUMENT: OPEN MYNOTES 

 TOOL: FACTBOOK TO MOSES 

 TOOL: HIGHLIGHT 

 TOOL: NOTES 

 TOOL: SEARCH 

 TOOL: INFORMATION 

 TOOL: TEXT COMPARISON 

 TOOL COMPARE VERSIONS: COMPARE ON MT4.1 

 TOOL PASSAGE ANALYSIS (compare pericopes): COMPARE ON MT4.1 

 LAYOUTS: LOAD LAYOUTNAME 

Command Searches 
 [ENTER] to search Preferred Bible 

 [CTRL]+[ENTER] to search Top Bibles 

 [CTRL]+[SHIFT]+[ENTER] to search Entire Library 
 

 SEARCH: SEARCH FOR TRUTH - opens a Basic Search and searches the Library for the word “truth.” 

 SEARCH: BIBLE SEARCH LOVE BEFORE "THE WORLD" 

 SEARCH: BIBLE SEARCH PRAY* NEAR FAST* 
 
For more advanced searches cf. Custom Guide Search Templates 
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Legend of All Logos Shortcuts 
 Click PROGRAM SETTINGS (3 Dots at very top right of program… or hit [F1]) > LOGOS BIBLE SOFTWARE 

HELP > in TOC find “ADVANCED” > WINDOWS KEYBOARD SHORTCUTS > Click that > Scroll Down just a 

little, to: > LOGOS SPECIFIC 
 You may want to BOOKMARK this or ADD TO FAVORITES (cf. Favorites & Bookmarks) 

Great Keyboard Shortcuts 

[SHIFT] + [CLICK] Toolbar Shortcut 
 This is actually a Mouse Shortcut 

 [SHIFT] + [CLICK] any shortcut and resource or tool will open as a Floating Panel! 

[F7] INSTANT PARALLEL BIBLES - Instant Pop-Up of 5 Favorite Bible Versions 
 [F7] will open up your 5 Favorite Bibles right to the current passage of the bible you are reading! 
 Cf. Prioritizing Resources & Your Preferred (favorite) Bible to learn how to PRIORITIZE your favorite bibles. 

[F11] FULL SCREEN Book / FLOAT Book 
 [F11] – Goes to “Reading View” which takes your active book and makes it full screen. Tap F11 again to exit Full 
Screen Reading View (F11 does this in many programs; web browsers for example). 

 [CTRL] + [F11] - Instantly Pop-Out the current book you are looking at (now it’s in it’s own window so you can 

[ALT] + [TAB] back and forth between this book and another program (e.g. Logos). Use [CTRL] + [SHIFT] + 

[F11] if you want to Dock it back into Logos. 

 Another way to do these is to click on the PANEL SETTINGS (3 Vertical Dots top right corner of any book) and 

choose > “FLOAT THIS PANEL” or “DOCK THIS PANEL” 

[F8] [ESC] DRAWING MODE (Markup) 
 [F8] Turns it on / [F8] Clears any Markups / [ESC] toggles it off 

[CTRL]+[SHIFT]+[F] SEARCH INLINE 
 

[CTRL]+[SHIFT]+[W] CLOSE ALL Panels 
 Method 1: [CTRL]+[SHIFT]+[W] 
 Method 2: Create A Shortcut 

 COMMAND BAR > TYPE “CLOSE ALL” > DRAG COMMAND TO SHORTCUTS BAR 

 

[Lt / Rt] PARALLEL RESOURCES 
 Left / Right Arrow Keys navigate to PREVIOUS / NEXT Parallel Resources 
 Some books have “Parallel Resources”… for example: bibles, commentaries that cover the same passage, and 
dictionaries. So if you are reading a bible and you use the  / ➔ arrows, it will go to other bibles.  
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Parallel Resources – Reordering Parallel Priorities 

 LIBRARY > PANEL SETTINGS (3 Vertical Dots Top Right of the Window) > PRIORITIZE RESOURCES > 

DRAG & DROP up and down to reorder them 

Parallel Resources – Viewing them 
Any book that has Parallel Resources, will have the following tool: 

 

Making Personal Collections Show in Parallel Resources 
 If you have created any Personal Collections, you can make them available in Parallel Resources 
 To learn more about Personal Collections see: Custom Searchable Collection 

 TOOLS > COLLECTIONS > OPEN > Click one of Your COLLECTIONs > Click Checkbox “SHOW IN PARALLEL 

RESOURCES” 
 

 

All Keyboard Shortcuts 

VIEW Keyboard Shortcuts 
 [CTRL] + [+] – Zoom In 

 [CTRL] + [-] – Zoom Out 

 [F7] – Comparison of Active Verse / Selected Text 

 [F8] – Enter Drawing Mode or clear drawing 

 [F11] – Toggle Show Reading View (available in all panels) 

NAVIGATION Keyboard Shortcuts 
 [CTRL] + [D] – Add to Favorites 

 [CTRL] + [SHIFT] + [1...9] – Set Bookmark 

 [ALT] + [] Next TOC Entry   |    [ALT] + [] Previous TOC Entry 

 [ALT] + [] Back   |    [ALT] + [➔] Forward 

 [➔] – Next Parallel Resource 

 [] – Previous Parallel Resource 
 [CTRL] + [➔] – Next Parallel Resource (if current resource has horizontal scrollbar) 
 [CTRL] + [] – Previous Parallel Resource (if current resource has horizontal scrollbar) 
 [CTRL] + [SHIFT] + [➔] – Next equivalent resource 
 [CTRL] + [SHIFT] + [] – Previous equivalent resource 

 [SPACEBAR] – Page Down 
 [SHIFT] + [SPACEBAR] – Page Up 
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TAB Keyboard Shortcuts 
 [CTRL] + [Page Up] – Previous Tab 
 [CTRL] + [Page Down] – Next Tab 
 [CTRL] + [T] – New Tab 

 [CTRL] + [SHIFT] + [T] – Reopen Last Closed Tab 

 [CTRL] + [SHIFT] + [N] – Duplicate Current Tab 

 [CTRL] + [W] – Close Tab 

 [CTRL] + [SHIFT] + [W] – Close All Tabs 

INTERFACE Keyboard Shortcuts 
 [ALT] + [H] – Home Page 

 [ALT] + [L] – Library 

 [CTRL] + [L] – Library Floating Window 
 [ALT] + [S] – Search 
 [CTRL] + [SHIFT] + [S] – Search in a floating window 
 [ALT] + [D] – Command Box 
 [ALT] + [O] – Documents menu 
 [ALT] + [G] – Guides menu 
 [ALT] + [T] – Tools menu 
 [ALT] + [P] – Help menu 

 [ALT] + [-] – Panel Menu 
 [CTRL] + [G] – Go to Reference Box 

 [CTRL] + [H] – History 

 [CTRL] + [SHIFT] + [I] - Information Panel 

INDUCTIVE BIBLE STUDY (Matthew 4:11-12) 

PART A: OBSERVATION 

STEP 1: READ the passage in its context SEVERAL TIMES 

Become Familiar with the Passage and Its Context 
 This helps us understand how the passage fits in the overall context of the bible 
 This gives us better understanding of the text 
 This helps us ask better investigative questions of the text 
 Who What Where When Why How 

Identify important themes an connect to the BROAD THEMES of the Bible 
 
Organize Your Library and Create Your Own Layout 

 Have the best resources open (Favorite Bible, Bible Dictionary, Study Bible, & Commentary) 
 Read the Passage Slowly and Mark It up 
 Cf. Notebooks: Highlights & Notes; here’s a sample:  
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Key Things to Look For: 

 Repeated Words 
 Contrasts 
 Comparisons 
 Lists 
 Figures of Speech 
 Cause & Effect Statements 
 Question & Answer Statements 
 Purpose Statements 
 Dialogue 
 Conditional Clauses 
 Actions of God 
 Actions of People 
 Emotional Terms 
 Shifts in the Narrative 
 Types of Verbs, Conjunctions, & Pronouns 

 
NOTE: If your book starts to have too many visuals, you can toggle anything off or on (cf. Visual Filters) 

STEP 2: Identify Important Themes and Connect to Broad Themes of the Bible 
 Identify and Research the Main Themes 
 The easiest way to do this is with the Topic Guide (cf. Topic Guide) 
 Broaden Your Knowledge about Biblical Themes 
 Sources for Topic (Theme) Studies: Commentaries, Bible Dictionaries, and Thematic Outlines 
 Thematic Outlines, cf.  
 Best Tools for this are the Topic Guide (cf. Topic Guide) and the Sermon Starter Guide. 
 ENGLISH <-> GREEK/HEBREW - We can easily toggle between English and the original language. 
 VERSE REFERENCE? What should you type in for the periscope (section) of scripture?  Consult trusted 
commentaries to see how the commentators separated the sections (e.g. many commentaries break Jesus’ 
Temptation in Matthew 4 to Matthew 4:1-11 (cf. Sermons Starter Guide) – especially the Thematic Outlines Section 
(scroll down to “Temptation…”) of the Sermon Starter Guide and the Factbook in the Topic Section of the Topic 
Guide 
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STEP 3: Compare Bible Translations 
 INTERACTION & TEXT – We are looking for Interaction Differences and Textual Differences 
 BIBLES ARE COMMENTARIES - All translators must make interpretative decisions; as a result each bible is in itself, a 
sort of commentary. There is no such thing as a Literal Translation 

 Open the Text Comparison Tool (cf. Text Comparison) 
 Open some bibles side by side and then quickly navigate your favorites using Parallel Resources (cf. PARALLEL 
RESOURCES) 

 
Use the Information Panel (cf. Information Panel Tool) 

 Open the Information Panel, the ESV, and the KJV (the Information Panel won’t work in the Text Comparison Tool) 
 Using the Information Panel, let’s hover over these words in the ESV Bible:  
 Mt 4:1 tempted (ESV translation) | tempted (KJV translation) 
 Mt 4:7 test (ESV) | tempt (KJV translation) 

 
When we hover over the words tempted and test in the ESV, the Information Panel (in the Definition Section) shows 

that they both have the same Greek Root Word () – we don’t need to know Greek to observe that. This is why the 
KJV translators used the word tempt in both verse 1 and 7… they were emphasizing the similarity of the two words.  
 
We can also observe that the word tempt has a broad range of meanings in both English and Greek; this why the ESV 
translators chose a different word (i.e. test). 

STEP 4a: Explore Context: LITERARY 

Four Contexts We Will Need to Explore: 
 A Literary Context 
 Intertextual Context 
 Historical Context 
 Cultural Context 

Explore the Literary Context: GENRE 
 Law (e.g. Leviticus) 
 Poetry (e.g. Psalms) 
 Narrative (e.g. Judges) 
 Epistlatory (e.g. Romans) 
 NOTE: Of course, many books of the bible have multiple Genres in them and so it will depend on what passage or 
periscope we are reading 

 When reading or studying a narrative in the Gospel accounts, we need to be aware of both historical contexts: that 
of Jesus, and that of the evangelist (Matthew). 

 The easiest way to determine the Genre of the passage we are working in is to use the Factbook (cf. Factbook) 
 Type “Matthew” in the Factbook and then choose the entry that has “man, apostle, author…” Expand the Form 
Section and look under Style: you may have a resource that talks about the Genre. If you don’t have access to the 
Form Section, just dig around and see if you can find an article in a commentary or a dictionary on Genre. 

 The one thing that becomes apparent is that Matthew is a Community Book written to churches with Jewish 
Christian readers.  

Explore the Literary Context: SURROUNDING TEXT 
 Context determines meaning, not only at the word level, but at the sentence and paragraph level 
 The 1st step is to read the entire book several times 
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 The 2nd step is to get the overall argument / flow of the book by consulting a Summary in an OT or NT Introduction. 
To see if you have a book in your library just open the library and type “Introduction” If not, you may want to open 
a commentary to Matthew 1:1 and scroll up a bit – many commentaries will have a summary and outline of the 
entire book at the beginning of the commentary. 

 
Now let’s use these two guides: 

 Passage Guide – focus on Commentaries Section and Cross References Section as well as other sections (cf SEARCH 
& FIND) – You can type subjects or verse references in the upper left 

 Exegetical Guide – (cf. Exegetical Guide) 

STEP 4b: Explore Context INTERTEXTUAL 

Explore the Intertextual Context: PARALLEL PASSAGES 
 Let’s start by looking at the other Gospel accounts. 

 Highlight MT 4:1-11 > RT-CLICK > “MATTHEW 4:1-11 REFERENCE” > PASSAGE GUIDE > PARALLEL 

PASSAGES SECTION 

 Try opening some of these resources and looking through them. We immediately notice A) How short Mark’s is B) 
The change in the order (Matthew may have wanted to emphasize Jesus’ sonship succeeded in obedience through 
the temptation whereas Israel, as God’s son, failed. Luke may have wanted to emphasize Jerusalem) 

Explore the Intertextual Context: PASSAGES THAT QUOTE OUR PASSAGE 

 GUIDES > PASSAGE GUIDE > CROSS REFERENCES 

Explore the Intertextual Context: PASSAGES QUOTED WITHIN OUR PASSAGE 

 GUIDES > PASSAGE GUIDE > CROSS REFERENCES 

Explore the Intertextual Context: INTERTESTAMENTAL CONNECTIONS 
 In Mt 4:6 (ESV) there is a superscript (d) before “He will command his angels…” -- that tells us Satan is quoting Psalm 
91:11-12. 

 If you have it (Paid Logos), TOOLS > PSALMS EXPLORER. If not, PASSAGE GUIDE > COMMENTARIES 

SECTION 
 Satan was encouraging Jesus to force God’s hand -- but God wants Jesus to rely on His protection – not demand it. 
God is a refuge and a fortress… so Jesus should not fear and should not test His Father. 

 Read some of the other Psalms of Trust that commentaries recommend 

STEP 5a: Explore Context HISTORICAL 

Explore the Historical Context of the EVENT: GEOGRAPHY AND TIME 
 E.g. the historical events that Matthew writes about are separated in time from the historical situation when 
Matthew us writing and his audience at that time. 

 GUIDES > ATLAS (paid version of Logos; cf. Atlas) 
 If you don’t have the Atlas Tool, try typing “Maps Matthew” in the Command Box (top of program); you may find 
something under the Library Section, Media Section, or other places 

 We discover that this temptation event occurred at the beginning of Jesus’ ministry. We discover that his 
temptation occurred right after he was baptized: 

 Jesus’ return from Egypt || Israel’s deliverance from Egypt 
 Jesus Baptized || Israel’s passage through the sea in Exodus 
 Jesus is God’s Son whom He is well pleased || God’s displeasure with His son, Israel 
 Jesus is Tempted 40 days || Israel’s 40 years wilderness wanderings 
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 Jesus (after temptation) crosses back over the Jordan || Joshua crossed after 40 years into the promised land 
 In Mt 4:15 Matthew quotes Isaiah and mentions the Jordan 
 Jesus then calls the 12 disciples || further connection to the 12 tribes of Israel 

 
NORMALLY, THIS INTERPRETATION SHOULD NOT BE DONE YET (we are still in OBSERVATION)… BUT: 

 The New Son of God will NOT FAIL 
 The New Exodus WILL SUCCEED 
 Jesus quotes 3 passage of scripture – all are from Deuteronomy 

The passages Jesus quotes from Deuteronomy are about that total commitment 
to God that this wilderness experience is designed to test. Jesus passes the 

test… then he crosses the Jordan and brings light into the darkness. 

Explore the Historical Context of the EVENT: PHYSICAL SETTING 
 E.g. when the Tempter takes Jesus to the Holy City and to the Temple, we shouldn’t just assume we understand 
where / what that is / means. Solomon’s Temple? Zerubbabel’s Temple? Ezekiel’s Temple? Herod’s Temple?  

 Bible Dictionaries are the perfect resources to answer these types of questions. A good Study Bible or Commentary 
should also help.  

 In Logos this becomes far easier. In Matthew 4:5, RIGHT-CLICK on the word TEMPLE – Depending on the Logos 

Version we have, we may immediately we see that this is HEROD’S TEMPLE; go ahead and click that. 
 If we have a basic version of Logos, then it would be easier to view a Commentary or a Study Bible (instead of trying 
to do a Topic Study Guide on “Temple” which would yield results that are too generic). 

 So if you have a basic version of Logos, simply RIGHT-CLICK “TEMPLE” (or anywhere on verse 5) and click > 

MATTHEW 4:5 > PASSAGE GUIDE > and click on your commentaries to ascertain what Temple Matthew is 
referring to here. 

Explore the Physical Setting with the EXPLORER TOOL 
 We see that Matthew is referring to Herod’s Temple.  
 Another thing to try is using the Explorer Tool (cf. Explorer) 

 RIGHT-CLICK TEMPLE (or any word in verse 5) > SELECT MATTHEW 4:5 > EXPLORER > click HEROD’S 

TEMPLE (clicking this will open the Factbook Tool) > expand LIBRARY RESULTS > BY RESOURCE 
 Now, make sure to expand some of these results (especially BiblePlaces.com, Faithlife Infographics, and Faithlife 
Photos! 

 Under Infographics, one of the options is Temple Comparison which compares the sizes of Herod’s Temple to 
Solomon’s Temple, and an American Football field! HEROD’S TEMPLE WAS MASSIVE and totally DOMINATED the 
landscape in Jerusalem. 

Explore the Historical Context of the WRITER / BOOK 
Dictionaries, Commentaries, & Bible Introductions are great tools for finding this information.  
 
Logos’ Factbook (cf. Factbook) will help you achieve this process much more easily. Just at least read one short article 
from each Section… to understand the Gospel of Matthew as a whole. 
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STEP 5b: Explore Context CULTURAL 
Cultural Context Involves:  

 Customs 
 Traditions 
 Economics 
 Politics 
 Social Setting 
 
 Primary Sources = Texts written around the same time as the text we are studying. E.g., Josephus wrote about the 
Jewish people in the 1st century.  

 Secondary Sources = Contemporary resources that take everything we know today about the ancient world (they 
will use primary resources) and then describe the culture of the biblical world. 

 

MATTHEW 4:2 > RIGHT-CLICK “FASTING” > TOPIC GUIDE (cf. Topic Guide) 
 LBD (Lexham Bible Dictionary) says that Jesus fasted, perhaps to express reliance on God in times of temptation. 
 LBD also says (under the heading “Fasting in the Early Church”) that people in the early church often fasted. 
 Just below that, you will see Primary Sources from early Christian writings -- that you can hover over or click to 
read. 

 In fact, the author says that the early church fathers may have believed that fasting could conquer temptations and 
prepare people for worship. 

 
NOTE: you could also use the Factbook here (cf. Factbook) – and depending on the version of Logos you have, you may 
have a Cultural Section which would yield even more powerful results. 
 
More Advanced Research 

 Searching for a single word leaves out synonyms and concepts that can’t be expressed by just one English word.  

 MATTHEW 4:2 > RIGHT-CLICK “FASTING” > ALL RESOURCES to get a much more thorough search. 
 For more on searching cf. SEARCH & FIND  

Since the bible contains so much Narrative Genre, the following (Characters) 
is very important when reading the bible. 

STEP 6a: Explore Characters: ACTION 

Characters in Matthew 4:1: 
 Jesus 
 Holy Spirit 
 Devil 
 Jesus interacts with Spirit 
 Then, Jesus interacts with the Devil 

Is this the only time in scripture that Jesus and Satan interact? 

Use A Bible Dictionary  
 A Bible Dictionary can be very helpful for this. Some of them pay heavy attention to characters in scripture. 
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 LBD (Lexham Bible Dictionary) for example, if you type “temptation” one of the articles that populates is 
“Temptation of Jesus”. In that article, there is a great description of the characters, as well as references to other 
places in scripture where Jesus and Satan interact (cf. https://ref.ly/logosres/lbd?hw=Temptation+of+Jesus) 

 To learn how to create a hyperlink like the one above, cf. Copy Location As (Reference Hyperlink) 

 
To Create a Word Image like the one above, cf. INTERESTING WORDS in this section: Interesting Words Section 
(Passage Guide) 

What do we do when we want to find all references in the bible to someone that goes by different names? 
 Satan, Tempter, Deceiver, Devil, Lucifer 
 An English concordance won’t work here. We need the original language root word  
 Often, the more significant a character, the more names. 
 Abraham: Abram, my master, father of many nations, our forefather, patriarch, etc 
 Moses: servant of the Lord, man of God, servant of God, His chosen one, etc 
 David: son of Jesse, man of God, my lord, man in accordance with my own heart, etc 
 Jesus has even more names. And to make matters worse, pronouns take even more work because the context in 
which they appear must be studies 

 
If you have a paid version of Logos, you can do a simple, powerful, thorough method of this; cf. Person Search 

STEP 6b: Explore Characters: WORDS 

How do Authors use Characters to Explain: 
 Author’s direct description of characters 
 Response of other characters 
 A character’s name / epithet 
 A character’s self-characterization 
 Recorded thoughts (though motivation behind this are sometimes difficult to determine) 
 Recorded speech (though motivation behind this are sometimes difficult to determine) 
 Recorded actions (though motivation behind this are sometimes difficult to determine) 

Peculiarities & Trends 
 It’s always good to look for peculiarities that will shine meaning 
 Also, look for trends (author doing similar things in other chapters, other books, etc) 
 Peculiar that Jesus talks about bread in verse 4:4 
 Let’s look for a pattern (trend) 

 TOOLS > SEARCH > BIBLE | ALL BIBLE TEXT | ALL PASSAGES | LEXHAM ENGLISH BIBLE > “BREAD” 

(after the search is done try selecting different views: GRID, VERSES, ALIGNED, ANALYSIS) 
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 We notice that bread is often used as a symbol for care and provision 

 Let’s focus in on the Gospel accounts; keep the same search open but change “All Passages” to “GOSPELS” and hit 

[ENTER] 
 In Matthew 6, Jesus talks about “daily bread” when talking to the disciples and modeling how to pray 
 In Matthew 7, he compares a caring father to a father who knows how to give bread to his son 
 In Matthew 16, Jesus is discourages by how his disciples forgot about his love for them and his ability to provide 
bread for them 

 For paid versions of Logos: in Matthew 4:4 RIGHT-CLICK “SATAN” > “SATAN ADDRESSEE” > SEARCH 

THIS RESOURCE INLINE… this will show you every time Satan is addressed in scripture. Zechariah 3:2 has very 
similar language to Jesus’, “Yahweh rebukes you, O Satan! Yahweh who has chosen Jerusalem rebukes you! Jude 9 
also speaks of a time that Satan was rebuked 

PART B: INTERPRETATION 
Fight the urge to move from Observation right into Application. It’s a temptation for all of us. We must first seek to 
answer, “What does the text mean?” (i.e. Interpretation) 

Why did God decide to include this passage in the scriptures? 
 
What did the author have in mind when they wrote it? 
 
What did the passage mean to the original audience? 
 

STEP 7a: Study IMPORTANT WORDS & CONNECT them to the rest of SCRIPTURE 
 Writers and speakers are much more precise and deliberative when they choose the words they use 
 We have a number of words to choose from 
 We have a number of ways to arrange those words 
 Biblical writers were highly purposeful in the words they chose and how they arranged those words 
 They often used words to indicate structure, Show emphasis, and connect their writings to other books in the bible 
(especially the Old Testament) 

Method A) Use Biblical Theology Books and Theology Sec tions of Commentaries 
 

Method B) Familiarity: Reading the book of the Bible Multiple Times  
 Nothing is as powerful as familiarity of the resource – to discover the important themes the author deploys 
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 Read the book in one sitting 
 Read the book in one sitting on multiple occasions… important themes will begin to jump out 

While words convey meaning and studying them is essential… we are always at 
risk of projecting into the text (seeing what we want to see… i.e. biases). 

 Words are part of a larger context and they have their own meaning 

Method C) WORD FREQUENCY (INTERESTING WORDS TOOL)  
 
GOAL: Find the Most FREQUENTLY USED WORDS in the Particular Passage 
Cf. INTERESTING WORDS in this section: Interesting Words Section (Passage Guide) 

  

Method D) CONCORDANCE 
 Wilderness is another unusual word. Let’s see where else the word is used in Matthew, by looking at the root (e.g. 
RUN is the root of run, ran, runs, running, etc) of the original language 

 RIGHT-CLICK WILDERNESS (Mt 4:1) > Hover over each word in the right page until “ROOT” appears (which is 

ερεμος) > THIS RESOURCE (INLINE) 
 We see Jesus goes out to the wilderness to be baptized 
 John prepares the way for Jesus, in the wilderness 
 The Spirit leads Jesus further into the wilderness for the temptation 
 All this further strengthens the connection between Jesus’ Temptation in the Wilderness, and the Israelites’ 
Wilderness wanderings. 

 Everywhere Israel failed, Jesus succeeded. Jesus is the fulfillment of everything Israel should have been. 
 “Angels” (cf. v 6) is another interesting word 

 RIGHT-CLICK “ANGELS” > ANGELS > THIS RESOURCE INLINE 

 4:11 – angels came and ministered to Jesus 
 13:41 – Jesus sends out HIS angels 
 25:31 – Jesus comes in glory with all HIS angels 
 26:53 – Jesus has more than 12 legions of angels at his call 
 So when Satan tempts Jesus to call on angels… we realize that would be wrong for Jesus to do, although HE 
COMMANDS LEGIONS. So this is very telling as to what this passage is about. Jesus is not supposed to do it in His 
own strength – rather, He is to be dependent upon His Father 

STEP 7b: Study IMPORTANT PHRASES & CONNECT them to the rest of SCRIPTURE 

Ways To Approach Interpretation 
 1) Give Priority to Intention of Author (the author primarily determines meaning) 
 2) Give Priority to Intention of Reader (the reader primarily determines meaning) 

There is a major movement in contemporary culture to move toward the reader 
determining the meaning of a text. “What does the text mean to me?” 
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Even many Christians, whether they realize it or not, ask themselves, “What does the text mean to me?” Obviously, life 
application is important, but never before understanding the author’s original intent – to the best of our ability.  

The first question must always be, 
“What did the author intend the text to mean?” 

“I am spiraling nearer and nearer to the text’s intended meaning as I refine my hypotheses and 
allow the text to continue to challenge and correct those alternative interpretations, the not 
guide my delineation of its significance for my situation today.” 

- Grant Osborne, “Hermeneutical Spiral” 
 

 Using a regular concordance is it extremely difficult to find occurrences of phrases. 

 In Mt 4:6 SELECT “IT IS WRITTEN” > RIGHT-CLICK > IT IS WRITTEN > SEARCH THIS RESOURCE 

(INLINE) 
 it is written appears about 10 times in Matthew! 
 As we look at verses we realize that Matthew has a very heavy dependence on the OT – he’s focused on Christ as 
the fulfillment of OT expectation.  

 

IMPORTANT NOTE: FROM THIS POINT FORWARD (REGARDING THE “INDUCTIVE 
BIBLE STUDY” SECTION), ALMOST ALL OF THE INDUCTIVE STUDY TOOLS WILL 

REQUIRE A PAID VERSION OF LOGOS. ALSO, FROM THIS POINT FORWARD THERE 
WILL BE LESS EXPLANATION, FEWER SCREENSHOTS AND FEWER WORDS TO 

DESCRIBE STEPS. 

 
We can find all the Sermon Themes that Logos Scholars have tagged. 
 

 
 

RIGHT-CLICK VERSE 7 > EXPAND “SATAN (SERMON THEME) > SCRIPTURE > SERMON STARTER GUIDE 

> THEMATIC OUTLINES > SCRIPTURE UNDERSTANDING > THROUGH DILIGENT STUDY 

 
We find the following verses: 
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2 Timothy 2:15 (ISV) — 15 Do your best to present yourself to God as an approved worker who has nothing 
to be ashamed of, handling the word of truth with precision.  
 
Acts 17:11 (ISV) — 11 These people were more receptive than those in Thessalonica. They were very willing 
to receive the message, and every day they carefully examined the Scriptures to see if those things were so.  
 
In the cross references from Acts 17:11 we find: 
John 5:39 (ISV) — 39 You examine the Scriptures carefully because you suppose that in them you have 
eternal life. Yet they testify about me.  
 
Jesus condemned his audience for misunderstanding the bible. 

Research Words in the Original Languages 

If we haven’t spent years in original language study – we must approach this 
with great humility. As we study the Greek and Hebrew, we should always go to 

biblical scholars (e.g. via commentaries) to check our findings. 

In Satan’s 3rd Temptation he offers “The Kingdoms of the World…” Why is this tempting to Jesus; is this used somewhere 
else in scripture?  

Morphological Searches 
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Morphological Proximity Search 
Let’s find every place that the Greek word for World is within 8-10 of the Greek word for Kingdom: 
 

 
 

lemma: NEAR lemma: 

 

COPY “lemma:" > RIGHT-CLICK WORLD > RUN SAME SEARCH > type “NEAR” > PASTE previous 
search: 
 

 

 
 
Results: 

 
 
Satan was offering Jesus something, at the wrong time, and in the wrong way. He was distorting good gifts that God 
already gives.  
 
Searching in the original languages gives us more accuracy. If we search “serve” (v 10): 
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GREEK = 21 results (many of them are translated “worship” 
ENGLISH = 68 results  
 

 
 
Let’s quickly check our results by seeing what others have to say. 

Greek Search in Commentaries 

RIGHT-CLICK “SERVE” again: 
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In the search box delete everything except the Greek: <Lemma = lbs/el/λατρεύω> 
 

Let’s limit to the commentaries: CLICK “EVERYTHING” > and write “type:commentary” 
 
We’ll find that this word is always used in a cultic sense in the NT.  
 

RIGHT-CLICK one of JESUS’ QUOTATIONS (e.g. verse 7 “again it is written…”). Satan (sermon theme) > Expand > 
scripture (sermon them) > sermon starter guide > thematic outlines  
 

Word Studies 
 

Senses 
 

Grammatical And Semantic Roles 
 

Grammatical Constructions 
 

Textual Variants 

LEFTOFFHERE 
 

Understand the PURPOSE IN STRUCTURE 
 

https://www.identity-intelligence.org/


 

P a g e  |  56 W W W . L O G O S . C O M  

Summarize the BIG IDEA of the Text 
 

Check COMMENTARIES for INTERPRETATION 
 

Explore the DOCTRINAL IMPLICATIONS of the Passage 
 

PART C: APPLICATION 

Apply the Passage 
 

Find Personal Application 
 

Share Insight 
 

MISCELLANEOUS 

Avanced Searching Help 
• https://wiki.logos.com/search_help 

Hidden Books (Removing / Deleting Resources From Library) 
Library > find books to hide > [CTRL] + [RIGHT-CLICK] > HIDE THIS RESOURCE 

Logon as Different User [Ctrl+Click Desktop Icon] 
• Can also CTRL+Click StartMenu Icon > Don’t let go of CRTRL until Logon Screen Appears 

• Logos 9 makes this easier by just clicking on Your Account Picture (top-right of Logos software) 

Resource Paths on PC / Deleting Personal Books 
• https://wiki.logos.com/personal_books#Uploading_and_Deleting_books 

• C:\Users\PCNAME\AppData\Local\Logos\Data\lx2h3fca.u14\ResourceManager\Resources\ 

• C:\Users\ PCNAME \AppData\Local\Logos\Data\tciwnr54.gu2\ResourceManager\Resources\ 

• Personal Books Extension: .lbspbb 

GREEK TOOLS 

Greek Alphabet Typing - Windows System Keyboard 

Installing Windows Greek Font Set & Keyboard 
Control Panel > Clock and Region > Language Preferences > Add a Language > Greek Polytonic 
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Typing in Greek with Windows On-Screen Keyboard 
Start Menu > Type "Keyboard" > Select "On-Screen Keyboard" 

Toggle Different languages (with or without using On-Screen Keyboard) 

[LEFT ALT]+[SHIFT] - Toggle installed keyboards 

Typing in Greek with a Hard Keyboard (Polytonic Diacritical Marks) 

 

Punctuation 

 QUESTION MARK Q[SPACE] 

Accents 
 Acute ; (then type the vowel) 
 Grave ] (then type the vowel) 
 Circumflex [ (then type the vowel) 

Smooth Breathing 
 Smooth ' (then type the vowel) 
 Acute / (then type the vowel) 
 Grave \ (then type the vowel) 
 Circumflex = (then type the vowel) 

Rough Breathing 
 Rough " (then type the vowel) 
 Acute ? (then type the vowel) 
 Grave | (then type the vowel) 
 Circumflex + (then type the vowel) 

iota Subscript 
 [Shift] [ (then type the vowel) 

 
For a chart, and more on using Polytonic Combinations cf. Dr. Noah Warren Kelley’s manual: 
https://kelleys4christ.files.wordpress.com/2019/07/how-to-type-in-greek-in-windows-10.pdf 
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URLS TO LOGOS “STUFF”  

Miscellaneous 
Give Suggestions For Improvement - https://logos.uservoice.com/forums/42823-logos-bible-software-7 
Forums - https://community.logos.com/forums/ 

URLs to FREEBIES 1 
https://ebooks.faithlife.com/search?context=product&sortBy=savings&limit=15&page=1&filters=Live_Status%2BBiography%3Agenre-
biography_Genre%2BBiblical%20Studies%3Agenre-biblicalstudies_Genre%2BBusiness%3Agenre-business_Genre%2BChristian%20Group%3Agenre-
christiangroup_Genre%2BChristian%20Living%3Agenre-christianliving_Genre%2BCounseling%20and%20Psychology%3Agenre-
counselingandpsychology_Genre%2BEducation%3Agenre-education_Genre%2BFamily%20%26%20Relationships%3Agenre-
familyrelationships_Genre%2BHealth%20%26%20Fitness%3Agenre-healthfitness_Genre%2BHistory%3Agenre-history_Genre%2BMinistry%3Agenre-
ministry_Genre%2BPersonal%20Growth%3Agenre-personalgrowth_Genre%2BReligion%3Agenre-religion_Genre%2BPolitics%3Agenre-
politics_Genre%2BSections%20of%20the%20Bible%3Agenre-sectionsofthebible_Genre%2BTheology%3Agenre-theology_Genre%2BYoung%20Adult%20Non-
Fiction%3Agenre-youngadultnonfiction_Genre  
https://www.logos.com/products/search?q=price%3A0&start=0&sort=rel&pageSize=60  
https://ebooks.faithlife.com/search?context=product&sortBy=price-low&limit=60&page=1&filters=Live_Status  
https://faithlife.com/free-books/activity  
https://www.logos.com/free-book-of-the-month  
https://www.logos.com/products/search?q=&start=&unlocked=no&sort=pricelo&pageSize=60?utm_source=blog.logos.com&utm_medium=blog&utm_content=how
togetfreelogos&utm_campaign=promo-logospro2017  
https://noet.com/search?context=product&sortBy=price-low&facets=Status_Live&view=list  
https://ebooks.noet.com/search?context=product&sortBy=price-low&limit=15&page=1  
https://ebooks.faithlife.com/products/55923/lexham-intro-collection FREE RIGHT NOW! $160  normally - HURRRRRRRRY 
https://ebooks.faithlife.com/products/36564/lexham-bible-dictionary AWESOME FREE NOW!! Normally $150!!!!!!!!!!!!! 
https://ebooks.faithlife.com/products/36338/faithlife-study-bible FANTASTIC FREE RESOURCE - NORMALLY $65 HURRRRRRRY!! 
https://ebooks.faithlife.com/products/6162/lexham-english-bible-leb-with-audio-new-testament GREAT BIBLE FREE - NORMALLY $40 
https://www.logos.com/product/45437/crucial-questions-series 
https://ebooks.faithlife.com/products/365/the-scripture-alphabet-of-animals FOR KIDS!! 
https://ebooks.faithlife.com/products/677/the-abridged-brown-driver-briggs-hebrew-english-lexicon-of-the-old-testament 
https://ebooks.faithlife.com/products/40588/spiritual-intervention 
https://ebooks.faithlife.com/products/47671/daily-wisdom-for-women-2015-devotional-collection-january 
https://ebooks.faithlife.com/products/52718/jesus-calling-book-club-discussion-guide-for-women 
https://ebooks.faithlife.com/products/28593/disability-and-the-sovereign-goodness-of-god-resources-from-john-piper 
https://ebooks.faithlife.com/products/32727/alive-to-wonder-celebrating-the-influence-of-c-s-lewis 
https://ebooks.faithlife.com/products/121102/jesus-calling-book-club-discussion-guide-for-grief 
https://ebooks.faithlife.com/products/35728/the-7-day-prayer-warrior-experience 
https://ebooks.faithlife.com/products/24226/prayers-and-promises-for-christmas-biblical-encouragement-for-the-holiday-season 
https://ebooks.faithlife.com/products/144662/daily-truth-study-and-application-notes-for-the-365-day-connect-the-testaments-bible-reading-plan 
https://ebooks.faithlife.com/products/19854/extreme-love-discover-and-experience-gods-love-for-you 
https://ebooks.faithlife.com/products/28592/take-care-how-you-listen-sermons-by-john-piper-on-receiving-the-word 
https://ebooks.faithlife.com/products/29292/knowing-the-truth-about-jesus-the-messiah 
https://ebooks.faithlife.com/products/39289/hcsb-navigating-the-horizons-in-bible-translations 
https://ebooks.faithlife.com/products/52717/jesus-calling-book-club-discussion-guide-for-men 
https://ebooks.faithlife.com/products/124713/permission-to-ponder-contemplative-wisdom-for-the-spiritually-distracted 
https://ebooks.faithlife.com/products/40588/spiritual-intervention 
https://ebooks.faithlife.com/products/52719/jesus-calling-book-club-discussion-guide-for-athletes 
https://ebooks.faithlife.com/products/34023/principles-for-the-gathering-of-believers-under-the-headship-of-jesus-christ 
https://ebooks.faithlife.com/products/15795/a-holy-ambition-to-preach-where-christ-has-not-been-named 
https://ebooks.faithlife.com/products/155127/the-ridiculously-divine-comedy-a-sample-of-true-tall-tales 
https://ebooks.faithlife.com/products/23908/sanctification-in-the-everyday-three-sermons-by-john-piper 
https://ebooks.faithlife.com/products/44795/this-christmas-god-wants-you-to-know-inspiration-for-your-soul 
https://www.logos.com/product/583/the-love-affairs-of-a-bibliomaniac 
https://www.logos.com/product/8648/book-of-common-prayer-1979-daily-office-lectionary 
https://www.logos.com/product/8647/book-of-common-prayer-1979-sunday-lectionary 
https://ebooks.faithlife.com/products/29301/still-not-professionals-ten-pleas-for-todays-pastors 
https://ebooks.faithlife.com/products/37385/christmas-at-pebble-creek 
https://ebooks.faithlife.com/products/55154/the-joy-project-a-true-story-of-inescapable-happiness 

https://www.logos.com/
https://logos.uservoice.com/forums/42823-logos-bible-software-7
https://community.logos.com/forums/
https://ebooks.faithlife.com/search?context=product&sortBy=savings&limit=15&page=1&filters=Live_Status%2BBiography%3Agenre-biography_Genre%2BBiblical%20Studies%3Agenre-biblicalstudies_Genre%2BBusiness%3Agenre-business_Genre%2BChristian%20Group%3Agenre-christiangroup_Genre%2BChristian%20Living%3Agenre-christianliving_Genre%2BCounseling%20and%20Psychology%3Agenre-counselingandpsychology_Genre%2BEducation%3Agenre-education_Genre%2BFamily%20%26%20Relationships%3Agenre-familyrelationships_Genre%2BHealth%20%26%20Fitness%3Agenre-healthfitness_Genre%2BHistory%3Agenre-history_Genre%2BMinistry%3Agenre-ministry_Genre%2BPersonal%20Growth%3Agenre-personalgrowth_Genre%2BReligion%3Agenre-religion_Genre%2BPolitics%3Agenre-politics_Genre%2BSections%20of%20the%20Bible%3Agenre-sectionsofthebible_Genre%2BTheology%3Agenre-theology_Genre%2BYoung%20Adult%20Non-Fiction%3Agenre-youngadultnonfiction_Genre
https://ebooks.faithlife.com/search?context=product&sortBy=savings&limit=15&page=1&filters=Live_Status%2BBiography%3Agenre-biography_Genre%2BBiblical%20Studies%3Agenre-biblicalstudies_Genre%2BBusiness%3Agenre-business_Genre%2BChristian%20Group%3Agenre-christiangroup_Genre%2BChristian%20Living%3Agenre-christianliving_Genre%2BCounseling%20and%20Psychology%3Agenre-counselingandpsychology_Genre%2BEducation%3Agenre-education_Genre%2BFamily%20%26%20Relationships%3Agenre-familyrelationships_Genre%2BHealth%20%26%20Fitness%3Agenre-healthfitness_Genre%2BHistory%3Agenre-history_Genre%2BMinistry%3Agenre-ministry_Genre%2BPersonal%20Growth%3Agenre-personalgrowth_Genre%2BReligion%3Agenre-religion_Genre%2BPolitics%3Agenre-politics_Genre%2BSections%20of%20the%20Bible%3Agenre-sectionsofthebible_Genre%2BTheology%3Agenre-theology_Genre%2BYoung%20Adult%20Non-Fiction%3Agenre-youngadultnonfiction_Genre
https://ebooks.faithlife.com/search?context=product&sortBy=savings&limit=15&page=1&filters=Live_Status%2BBiography%3Agenre-biography_Genre%2BBiblical%20Studies%3Agenre-biblicalstudies_Genre%2BBusiness%3Agenre-business_Genre%2BChristian%20Group%3Agenre-christiangroup_Genre%2BChristian%20Living%3Agenre-christianliving_Genre%2BCounseling%20and%20Psychology%3Agenre-counselingandpsychology_Genre%2BEducation%3Agenre-education_Genre%2BFamily%20%26%20Relationships%3Agenre-familyrelationships_Genre%2BHealth%20%26%20Fitness%3Agenre-healthfitness_Genre%2BHistory%3Agenre-history_Genre%2BMinistry%3Agenre-ministry_Genre%2BPersonal%20Growth%3Agenre-personalgrowth_Genre%2BReligion%3Agenre-religion_Genre%2BPolitics%3Agenre-politics_Genre%2BSections%20of%20the%20Bible%3Agenre-sectionsofthebible_Genre%2BTheology%3Agenre-theology_Genre%2BYoung%20Adult%20Non-Fiction%3Agenre-youngadultnonfiction_Genre
https://ebooks.faithlife.com/search?context=product&sortBy=savings&limit=15&page=1&filters=Live_Status%2BBiography%3Agenre-biography_Genre%2BBiblical%20Studies%3Agenre-biblicalstudies_Genre%2BBusiness%3Agenre-business_Genre%2BChristian%20Group%3Agenre-christiangroup_Genre%2BChristian%20Living%3Agenre-christianliving_Genre%2BCounseling%20and%20Psychology%3Agenre-counselingandpsychology_Genre%2BEducation%3Agenre-education_Genre%2BFamily%20%26%20Relationships%3Agenre-familyrelationships_Genre%2BHealth%20%26%20Fitness%3Agenre-healthfitness_Genre%2BHistory%3Agenre-history_Genre%2BMinistry%3Agenre-ministry_Genre%2BPersonal%20Growth%3Agenre-personalgrowth_Genre%2BReligion%3Agenre-religion_Genre%2BPolitics%3Agenre-politics_Genre%2BSections%20of%20the%20Bible%3Agenre-sectionsofthebible_Genre%2BTheology%3Agenre-theology_Genre%2BYoung%20Adult%20Non-Fiction%3Agenre-youngadultnonfiction_Genre
https://ebooks.faithlife.com/search?context=product&sortBy=savings&limit=15&page=1&filters=Live_Status%2BBiography%3Agenre-biography_Genre%2BBiblical%20Studies%3Agenre-biblicalstudies_Genre%2BBusiness%3Agenre-business_Genre%2BChristian%20Group%3Agenre-christiangroup_Genre%2BChristian%20Living%3Agenre-christianliving_Genre%2BCounseling%20and%20Psychology%3Agenre-counselingandpsychology_Genre%2BEducation%3Agenre-education_Genre%2BFamily%20%26%20Relationships%3Agenre-familyrelationships_Genre%2BHealth%20%26%20Fitness%3Agenre-healthfitness_Genre%2BHistory%3Agenre-history_Genre%2BMinistry%3Agenre-ministry_Genre%2BPersonal%20Growth%3Agenre-personalgrowth_Genre%2BReligion%3Agenre-religion_Genre%2BPolitics%3Agenre-politics_Genre%2BSections%20of%20the%20Bible%3Agenre-sectionsofthebible_Genre%2BTheology%3Agenre-theology_Genre%2BYoung%20Adult%20Non-Fiction%3Agenre-youngadultnonfiction_Genre
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https://www.logos.com/free-book-of-the-month
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https://ebooks.faithlife.com/products/55923/lexham-intro-collection
https://ebooks.faithlife.com/products/36564/lexham-bible-dictionary
https://ebooks.faithlife.com/products/36338/faithlife-study-bible
https://ebooks.faithlife.com/products/6162/lexham-english-bible-leb-with-audio-new-testament
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https://ebooks.faithlife.com/products/52718/jesus-calling-book-club-discussion-guide-for-women
https://ebooks.faithlife.com/products/28593/disability-and-the-sovereign-goodness-of-god-resources-from-john-piper
https://ebooks.faithlife.com/products/32727/alive-to-wonder-celebrating-the-influence-of-c-s-lewis
https://ebooks.faithlife.com/products/121102/jesus-calling-book-club-discussion-guide-for-grief
https://ebooks.faithlife.com/products/35728/the-7-day-prayer-warrior-experience
https://ebooks.faithlife.com/products/24226/prayers-and-promises-for-christmas-biblical-encouragement-for-the-holiday-season
https://ebooks.faithlife.com/products/144662/daily-truth-study-and-application-notes-for-the-365-day-connect-the-testaments-bible-reading-plan
https://ebooks.faithlife.com/products/19854/extreme-love-discover-and-experience-gods-love-for-you
https://ebooks.faithlife.com/products/28592/take-care-how-you-listen-sermons-by-john-piper-on-receiving-the-word
https://ebooks.faithlife.com/products/29292/knowing-the-truth-about-jesus-the-messiah
https://ebooks.faithlife.com/products/39289/hcsb-navigating-the-horizons-in-bible-translations
https://ebooks.faithlife.com/products/52717/jesus-calling-book-club-discussion-guide-for-men
https://ebooks.faithlife.com/products/124713/permission-to-ponder-contemplative-wisdom-for-the-spiritually-distracted
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URLs to FREEBIES 2 

VIDEO COLLECTION 

LOOK AT THE BOOK VIDEOS BY JOHN PIPER - 101 VIDEOS 
https://www.logos.com/product/54898/look-at-the-book  
IF YOU DON'T HAVE THIS YOU MUST GET IT! The videos will NOT download to your computer, but you will have to be 
online in order to access them while you're in LOGOS. Although, if you really want them to download to your computer: 

 Logos > GO Bar > type “look at the book” > Open “Look At The Book Labs (VIDEO) 
 Once the resource is open > go to its settings (three little dots top-right of the “book”) > “Download All 

Media” 
PLEASE LET ME KNOW WHAT YOU THINK ABOUT THESE AMAZING VIDEOS! 

 

DIGITAL TOOLS 

Logos Desktop Wallpapers 
https://www.logos.com/product/56402/logos-desktop-wallpapers 
 

Hand-drawn Greek and Hebrew Fonts 
https://www.logos.com/product/53933/hand-drawn-greek-and-hebrew-fonts 
Download these hand-drawn Greek and Hebrew fonts for free! Created by in-house Greek and Hebrew experts, these 
fonts are used in the Logos 6 Greek Alphabet Tutor and Hebrew Alphabet Tutor. Download these fonts now to use in 
your own word processing programs. 
 

Original Languages Keyboards for Windows 
https://www.logos.com/product/53264/original-languages-keyboards-for-windows 
Ancient Language Keyboards allow us to type in different languages, like Greek or Hebrew, by mapping the ancient 
language characters to our physical keyboard. This has the significant advantage of allowing you to install and learn one 
keyboard and use it not only in Logos but also in any other Unicode-aware application (including Microsoft Word or the 
Google search bar). 

BOOK COLLECTION (ENGLISH) 

A Commentary on the Psalms 1–89, Volumes 1 & 2: Commentary 
https://www.logos.com/product/162795/a-commentary-on-the-psalms-1-89-volumes-1-and-2-commentary 
Allen P. Ross Publisher: Kregel, 2011–2013 
For thousands of years, the book of Psalms has been one of God’s people’s richest resources for worship and the 
spiritual life. It’s also one of the most complex and challenging sections of the Bible for expositors. Pastors, teachers, and 
all serious students of the Bible will find this commentary invaluable for developing their understanding of the Psalms 
and for improving their ability to expound it with precision and depth. Allen P. Ross guides the reader through a detailed 
exegesis, proposes a homiletical outline, and offers a summary expository idea of the message of each psalm. 
 

The Song of Songs: Bible Text 
https://www.logos.com/product/157796/the-song-of-songs-bible-text 
COMMENTARY by Iain M. Duguid Publisher: Inter-Varsity, 2015 

https://www.identity-intelligence.org/
https://www.logos.com/product/54898/look-at-the-book
https://www.logos.com/product/56402/logos-desktop-wallpapers
https://www.logos.com/product/53933/hand-drawn-greek-and-hebrew-fonts
https://www.logos.com/product/53264/original-languages-keyboards-for-windows
https://www.logos.com/product/162795/a-commentary-on-the-psalms-1-89-volumes-1-and-2-commentary
https://www.logos.com/product/157796/the-song-of-songs-bible-text
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This Old Testament book, ‘the best of songs’, has fascinated and perplexed interpreters for centuries. We hear the 
passionate melody of romantic love, and are confronted by erotic imagery—but whose love is described? Is it a couple’s 
love for each other, God’s love for his people, or a poem that speaks to love in all its dimensions? Iain Duguid’s 
commentary explains how the Song is designed to show us an idealized picture of married love, in the context of a fallen 
and broken world. It also convicts us of how far short of this perfection we fall, both as humans and as lovers, and drives 
us repeatedly into the arms of our true heavenly husband, Jesus Christ. Replacing G. Lloyd Carr’s The Song of Solomon, 
Duguid’s commentary on the Song of Songs utilizes up-to-date scholarship to paint a fresh picture of this provocative 
Old Testament text. 
 

A Commentary on Judges and Ruth: Commentary 
https://www.logos.com/product/162791/a-commentary-on-judges-and-ruth-commentary 
by Robert Chisholm Jr. Publisher: Kregel, 2013 
This definitive commentary sheds exegetical and theological light on the books of Judges and Ruth for contemporary 
preachers and students of Scripture. Listening closely to the text while interacting with the best scholarship, Robert B. 
Chisholm shows what the text meant for ancient Israel and what it means for us today. In addition to providing 
perceptive comments on the biblical text, he details a host of theological themes in both books. Discover in-depth 
treatments of motifs such as covenants and the sovereignty of God in Judges, and providence, redemption, loving-
kindness, and Christological typology in Ruth. Chisholm offers astute guidance to preachers and teachers by providing 
homiletical trajectories for each passage, focusing on how the content can be presented in the pulpit and the classroom. 
 

Nothing but the Truth: Upholding the Gospel in a Doubting Age (Study Guide) 
https://www.logos.com/product/156761/nothing-but-the-truth-upholding-the-gospel-in-a-doubting-age 
by John F. MacArthur Jr. Publisher: Crossway, 1999 
Scripture is clear about the fact that we must be prepared to communicate the truth of the Gospel when given the 
opportunity—and do it with the right attitude. But even when your tone is gentle and respectful, what, specifically, 
should you say when asked or confronted about your faith? And what is your overall responsibility to unbelievers as a 
disciple of Christ? Pastor John MacArthur responds to these very questions and more—with solid, biblical answers 
focused in four particular areas: • your attitude • your preparedness • the content of your answers • your 
priority in witnessing Combining a biblical study of evangelism, a rational defense of Christian beliefs, and a practical 
approach to evangelism, this book offers a well-rounded perspective that can help you gently and confidently give an 
answer for the hope you have in Christ. 
 

The Gospel of Thomas: Original Text with Commentary 
https://www.logos.com/product/17838/the-gospel-of-thomas-original-text-with-commentary 
by Uwe-Karsten Plisch, Gesine Schenke Robinson Publisher: Deutsche Bibelgesellschaft, 2008 
The Gospel of Thomas, a collection of words of Jesus, is one of the most significant extrabiblical texts of the early 
Christian era. This edition presents the texts in the classical languages and provides an English translation and a readily 
readable commentary. It includes: An introduction to the Gospel of Thomas, the complete Coptic text, the text of the 
Greek fragments, and a Greek retranslation of all logia with parallel texts from the canonic gospels, an English 
translation, an extensive commentary, and a bibliography. The introduction and commentary do not assume knowledge 
of the classical languages, making the Gospel of Thomas accessible to a broad audience. 

Beowulf 
https://www.logos.com/product/9944/beowulf 
Beowulf is one of the earliest and greatest epics in history. With its composition dated between the eighth and eleventh 
centuries, this Old English heroic poem is also regarded as the first important work of Anglo-Saxon literature. Set in the 
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region that is now southern Sweden, Beowulf is the story of a warrior and his three major battles against evil forces—
Grendel the demon, Grendel’s swamp-hag mother, and a great dragon. Composed by a Christian writer, Beowulf 
incorporates pagan ideals, concepts, and tradition, with Christian themes and stories. With the Noet edition of Beowulf 
you have access to one of the most famous English epics, enhanced by cutting-edge functionality. 
 

Richmond Times-Dispatch (6 vols. -- 1,355 iSSUES) 
https://www.logos.com/product/9946/richmond-times-dispatch 
The Richmond Times-Dispatch includes 1,355 issues and has been the primary daily newspaper of Richmond, Virginia for 
over the past 150 years. At the time of establishment in 1850, it was one of the very few non-partisan newspapers 
around and featured relatively unbiased articles. During the Civil War, Richmond became the capital of the Confederate 
states and the Daily Dispatch decided to promote the Confederate cause. The Daily Dispatch continued to produce a 
daily (except Sunday) publication throughout the war, but with inflation, a lack of supplies, and a need for some sort of 
revenue, its format was altered—including more advertisements than actual news. The Richmond Times-Dispatch 
chronicles the American Civil War from its rise in 1860 to its end in 1865. This collection of daily newspapers allows you 
to explore the events that took place in the city, state, and the Confederacy at large during the war. It features daily 
news, articles on movers and shakers of the Confederate government, and advertisements that capture the city’s 
economy, social structure, and culture during these pivotal years. 
 

Perseus Renaissance Collection (22 vols.) 
https://www.logos.com/product/9943/perseus-renaissance-collection 
The Perseus Renaissance Collection (22 vols.) is a compilation of the history and literature of the British Isles during the 
English Renaissance period. The Renaissance was a period of time known for a renewed interest and intellectual rise in 
literature, philosophy, politics, science, religion, and art. It is credited as a time period where new ideas, perspectives, 
and theories evolved. While this collection includes some works from the English Renaissance period, such as Defense of 
Poesie and Faust Book, it mostly directs its attention to a systematic study of the nature of literature during this time. It 
analyzes the works of Shakespeare, the literary style of the Renaissance, and the affect the literary style of writing had 
on its audience. The Perseus Renaissance Collection (22 vols.) also gives a concise history of England, Scotland, and 
Ireland, using secondary materials from the 19th and early 20th centuries. It provides a look into these nations’ culture, 
politics, and major events. This collection is full of sound scholarship and will help you better understand the historical, 
social, and philosophical context of key religious events and figures of that time. 
 

Perseus Civil War and 19th Century American Collection (340 vols.) 
https://www.logos.com/product/9942/perseus-civil-war-and-19th-century-american-collection 
The Perseus Civil War and Nineteenth-Century American Collection (340 vols.) is a comprehensive collection of works 
pertaining to the nineteenth century. It includes records, memoirs, biographies, and histories of people, places, and 
events. This collection mostly centers on the Civil War. It chronicles the rise and fall of the Confederacy and gives a 
concise military history of both the Union and Confederacy. Leaders of the Civil War are examined with biographies on 
key figures like Ulysses S. Grant, Benjamin Butler, Thomas J. Jackson, Jubal A. Early, Robert E. Lee, George B. McClellan, 
Oliver Otis Howard, George Gordon Meade, and Abraham Lincoln. Also included are personal war memoirs of women, 
children, nurses, African-American soldiers, and volunteer soldiers, giving perspectives on life and events that took place 
during the war. The Perseus Civil War and Nineteenth-Century American Collection (340 vols.) includes The 
Photographic History of The Civil War (10 vols.) which contains thousands of photographs of soldier life, military 
branches, prisons, and other images relating to the Civil War. With this collection you’ll also learn about the history of 
the United States with works and biographies of some of the most influential people of the nineteenth century. These 
texts focus on major events, politics, and the nation’s evolving structure and culture. Key figures comprised of 
abolitionists, women’s rights activists, scientists, and literary geniuses are highlighted, which include Lydia Maria Child, 
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Margaret Fuller Ossoli, Harriet Beecher Stowe, George Ticknor, William Lloyd Garrison, Charles Sumner, John Brown, Sir 
Henry Morton Stanley, and Thomas Wentworth Higginson. 
 

BOOK COLLECTION (FOREIGN OR MIXED ENGLISH) 

The Gospel According to Thomas 
The Gospel According to Thomas in English https://www.logos.com/product/17625/the-gospel-according-to-thomas-in-
english 
The Gospel According to Thomas in Greek https://www.logos.com/product/17624/the-gospel-according-to-thomas-in-
greek 
The Gospel According to Thomas in Coptic https://www.logos.com/product/17616/the-gospel-according-to-thomas-in-
coptic 
by Hans-Gebhard Bethge Deutsche Bibelgesellschaft, 1996 
This scholarly edition of the Gospel According to Thomas is taken from the Appendix of the Synopsis Quattuor 
Evangeliorum, ed. by Kurt Aland. For the first time this appendix published the Coptic version of the gospel together 
with new translations in English and German, and a Greek retranslation. For more information on the edition see the 
editor’s foreword in the English version. This digital edition makes the Gospel According to Thomas available in 
electronic format for the first time. The Logos Bible Software edition makes this resource more powerful and easier to 
access than ever before for scholarly work or personal Bible study. With the advanced search features of Logos Bible 
Software, you can perform powerful searches by topic or Scripture reference. Includes notes to give background 
information and alternative translations. Provides some marked passages which present analogies, but remains as an 
open question whether there is a relationship based upon a common history of tradition. 
 

Perseus Arabic Collection (37 vols. - ARABIC & ENGLISH MIX) 
https://www.logos.com/product/9941/perseus-arabic-collection 
The Perseus Arabic Collection brings you two English translations of the Quran and two Arabic-English lexicons. These 
works will bring you a deeper understanding of the Muslim faith, making this collection perfect for apologetics or 
comparative studies. One of the most significant pieces of modern literature is the Quran. The Quran is the single most 
important work in Arabic literature and the Muslim religion. According to Muslims, the Quran is considered to be the 
veritable word of God—following the Old and New Testaments—revealed to the prophet Muhammad through the angel 
Gabriel. This holy book of Islam provides the code of living for members of the Islamic faith, which accounts for over one 
billion people. Though Muslims believe that the Arabic translation of the Quran cannot be reproduced in any other 
language form, the two translations contained in this collection are rendered almost literally. Along with the two 
translations are two Arab-English lexicons, containing all the classical Arabic words. These invaluable resources make 
Arab language study available to you and will bring you greater understanding as you read through the Quran in its 
original language. As a result, you can learn what Muslims believe and use that knowledge in comparative studies, 
apologetics, and evangelism to Muslims. The Perseus Arabic Collection allows you to study the writings of Muhammad, 
and gain a better perspective and understanding of the Muslim faith and the text of the Quran. 
 

Esther Scroll: The Story of the Story (Greek Appendix Translation) 
https://www.logos.com/product/162978/the-esther-scroll-the-story-of-the-story 
NOTE THIS RESOURCE IS IN ALL GREEK!!! David J. A. Clines 1984 0.00 
The book of Esther emerges from complex origins. According to David J. A. Clines, the story combines elements from 
numerous literary, textual, and storytelling traditions. Through the telling and retelling of the story, the book as it 
appears in the modern canon slowly emerges. In this volume, Clines uncovers this fascinating history by examining the 
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literary and textual elements of the book, the shape of the story, and the shifts in meaning as new generations have 
retold the story and interpreted it for their own time. 
 

The OpenText.org Syntactically Analyzed Greek New Testament Glossary 
https://www.logos.com/product/169408/the-opentextorg-syntactically-analyzed-greek-new-testament-glossary 
THIS IS ANOTHER GREEK RESOURCE by Stanley E. Porter, Matthew Brook O’Donnell, Jeffrey T. Reed Publisher: Logos 
Bible Software, 2006 
The OpenText.org Syntactically Analyzed Greek New Testament offers a syntactic analysis of the Greek New Testament. 
The following resources are included: • The OpenText.org Syntactically Analyzed Greek New Testament • The 
OpenText.org Syntactically Analyzed Greek New Testament: Clause Analysis • The OpenText.org Syntactically 
Analyzed Greek New Testament: Glossary The OpenText.org analysis is done at three levels: The word level, the word 
group level and the clause level. This allows searching at the word level and also searching based on syntactic structure 
within the Greek New Testament. 
 

Duke Databank of Documentary Papyri (256 vols.) 
https://www.logos.com/product/9945/duke-databank-of-documentary-papyri 
The Duke Databank of Documentary Papyri is a collection of rare ancient manuscripts. These documents were written on 
various forms of writing material including papyri, ostraca, and wood tablets. This collection is solely compiled of 
documentary papyri: personal letters, receipts, various political documents, and other correspondence. The Duke 
Databank of Documentary Papyri gives you access to primary texts in Greek, Latin, Coptic, and several other languages. 
For more than a century, the discovery of papyri has revolutionized the study of the ancient languages, and shed new 
light on the history and culture of the ancient world. This database is the result of years of meticulous work to organize 
scattered materials, and the result is a vast database of documents. This vital corpus of primary source material gives 
you unprecedented access to the ancient world. Read letters, receipts, political documents, correspondence, and more. 
Supplement your study with original source materials. Enrich your word studies by comparing word usage between New 
Testament texts and this collection of papyri. 
 

Perseus Classics Collection (1,114 vols. - GREEK & LATIN) 
https://www.logos.com/product/9940/perseus-classics-collection 
The Perseus Classics Collection (1,114 vols.) contains works from classical Greek and Roman authors. This massive 
collection includes important Greek and Latin classics in their original languages; some works have an English 
translation. Greek and Latin grammars and commentaries are also included. The works in the Perseus Classics Collection 
allow you to carefully study Greek and Latin and further familiarize yourself with its literature and languages. 
Understanding these languages is an invaluable tool in the study of the New Testament. You can search and compare 
vocabulary in the New Testament and see how it was used classically, enhancing your word study. An English translation 
provided with many of the Greek and Latin classics, makes these resources accessible to you even if you’re not proficient 
in these languages. The thoughts and works of the playwrights, poets, physicians, mathematicians, and historians 
contained in the Perseus Classics Collection (1,114 vols.) enhance the mind—revealing ancient wisdom, theories, and 
thought—making these works vital tools for study. 
 
This collection includes the works of: 

 Aristophanes 
 Aristotle 
 Marcus Tullius Cicero 
 Terence 
 Homer 
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 Horace 
 Hippocrates 
 Plato 
 Plutarch 
 Seneca 
 Sophocles 
 Cornelius Tacitus 
 Tertullian 
 Xenophon 
 And many more! 

Manual Update and Version History 

20190703 Edits 
 Added Keyboard Shortcuts Section 

20190718 Edits 
 Moved entire “MISC” section to end of manual 
 Added many Free Resource URLs 

20190721 Edits 
 Added Copyright section at beginning 
 Added instructions for Using the Manual at the beginning 
 Update to pdf section of Using this manual in WORD vs. LOGOS 
 Dozens of minor edits on typos, etc 
 Improved Header Image positioning 
 Added visuals for Personal Books Tool (add Word Docs into Logos) 
 Added / Fixed many cross references 
 Added new command box shortcut 

20190722 Edits 
 Added: VIEWING RESOURCES > Send Hyperlinks Here 
 Added: VIEWING RESOURCES > Truncated Resource Tabs & Command Box Abbreviations 

20190723 Edits 
 Many minor edits (spelling, colors, hyperlinks, etc. – nothing structural) 
 Added a 2nd Cover Image for Logos Version (with an “8” in it for the Logos Version) 
 Added an “8” to the Manual Cover (to represent the Logos Version) 
 Updated: BIBLE TRANSLATIONS COMPARISONS > Bible Version Comparison Table with 5 new bibles (but missing 
Literalness ratings) 

 Mistakenly referred to the COMMAND BOX and the GO BOX as the same entity; removed all occurrences of “GO 
BOX” 

20190724 Edits 
 Added further content in INDUCTIVE BIBLE STUDY (Matthew 4:11-12). NOTE: most of this is only available in paid 
versions of Logos. 

20190725 Edits 
 Added: “Problems Rebuilding A Personal Book” to PERSONAL BOOKS TOOL (add Word Docs into Logos) 
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 Added: “Rebuilding - File Renaming Strategy” to PERSONAL BOOKS TOOL (add Word Docs into Logos) 

20190905 Edits 
 SEARCH & FIND > Find Notes & Highlights > Advanced Searching in Highlighting: Simplified, Reorganized, Clarified, 
& colored search syntax in green. 

20210124 Edits 
 GUIDES & TOOLS section moved above SEARCH & FIND section 
 Added LIST OF GUIDES, TOOLS, & WORKFLOWS Section 
 Many minor edits & adjustments including fixing CROSS REFERENCE HYPERLINKS 

20210125 Edits 
 CROSS REFERENCES – Rebuilt all cross-references (internal hyperlink) so they now work in the Logos Version of the 
Manual 

 HEADING COLORS – Changed all Headings from BLUE to BURGANDY to differentiate from the BLUE HYPERLINKS 
which (Logos auto converts the hyperlink colors upon Personal Book import). 

 TITLE PAGE LOGO – Changed Logo from “LOGOS 8” to “LOGOS” 
 

20210418 Edits 
 INTERLINEAR ICONS - Added Logos Interlinear Symbols (Symbols when a Bible word is right-clicked) to the section 
"USING INTERLINEAR IN ENGLISH BIBLES". 

 Organization > Notebooks: Highlights & Notes > NOTEBOOKS: EXPORT NOTES FROM A NOTEBOOK (from a 
specific resource) – Added exporting notes from a specific resource within a notebook 

20210510 Edits 
 GREEK TOOLS - Added new Section “Greek Tools” and specifically, added “Greek Alphabet Typing - Windows 
System Keyboard”. 

Updated Manuals & Forums for Logos Book Covers 
An updated manual has been posted in all three versions (i.e. PDF, WORD, LOGOS). The download links can be found 
here: https://community.logos.com/forums/p/182780/1057673.aspx#1057673 
 
You can also find Manual Covers (for the Logos Version) for download here: 
https://community.logos.com/forums/p/182780/1057871.aspx#1057871 
https://community.logos.com/forums/p/182780/1149830.aspx#1149830 
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